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Introduction

Digital video has become a new standard for conducting research in areas ranging from
engineering and scientific research to crash testing, human and animal biomechanics,
and sports analysis. As some experiments can be very costly or difficult to set up and
conduct, the greatest advantage video analysis offers is its non-contact and non-
destructive nature. But how does one extract the relevant information from a video and
turn that into usable data?

Welcome to the world of ProAnalyst.

Most motion analysis applications exist as part of a proprietary video acquisition package,
or with a specific industry or application in mind. ProAnalyst breaks that mold by
providing a series of video processing and motion analysis tools that can be applied to
any video or image sequence, regardless of content or acquisition method. Analysis
results can be instantly graphed and reviewed, overlaid with and compared to external
data, and exported to a variety of output formats for further analysis or presentation
purposes.

For all of its capabilities, learning to use ProAnalyst effectively can seem like a daunting
or overwhelming process. This guide, which has been divided into two sections, should
reduce the learning curve, and allow you the user to start utilizing ProAnalyst’s
capabilities to their fullest potential.

Section 1: ProAnalyst Essential Concepts provides a detailed breakdown of the
important concepts and most commonly used toolkits in ProAnalyst. ProAnalyst
Essential Concepts is not as in depth as the ProAnalyst User Guide, but rather is
structured to provide a simple reference and answers to many basic questions about
motion tracking options, data analysis, and outputting of results.

Section 2: ProAnalyst Tutorials provides a series of practical step-by-step lessons that
cover all of the major features and toolkits in ProAnalyst. The principles covered will
provide you with a solid foundation and working knowledge of ProAnalyst from which to
approach your own imaging applications.
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Working with Projects

What is a Project?

Projects provide a convenient and easy way to manage multiple video and data sources,
as well as any associated calibration, analysis, and processing files. Files associated with
a particular project are displayed in an interactive thumbnail view, allowing the project
itself to serve as a sort of book-keeping mechanism for keeping track of large amounts of
video and/or data.

Opening a Project
1. In the Menu Bar, select File > Open Project...
2. Browse for a project file (*.mpj), and click Open.

3. The Project Window will appear in the upper left corner of
the ProAnalyst screen.

Creating a Project
1. In the Menu Bar, select File 2 New Project.

2. An empty and untitled Project Window will launch.

Compact vs. Normal View
Project Windows can be displayed in one of two formats:

Compact View (above right) — Displays only the video image and the data graph. Play
controls are accessible in the Compact view by right-clicking on each video.

Normal View (below) — Displays information about the video and data files and provides
play controls for navigation in each video.

‘r, demofiles.mpj

CELTE
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To switch between the PROJECT TOOLBAR ICONS

Compact/Normal and

Horizontal/Vertical views, click

on the gpproprlate icons on "m Normal View — Display video, data,

the Project Toolbar (Icon W Align (Videos) Vertical play controls, and information panel
i i o= Fit Window to Content

qetalls are described on the . Align (Videos) Horizontal [HVVIBCOWRORZONIEHLS

right.) or use the context menu g Create Timeline(s)

by right-clicking anywhere in

the Project Window.

; Add Video 7 Compact View — Display only the
= . ’: video image and the data graph.
[=] Save Active Document

The default viewing mode for all newly opened project windows can be set by selecting
Edit > Program Options.

Adding Videos

add vidzo(s). ..
Remaoyve Selected Videa

|
1. Right-click the Project Window to open a pop-up menu. '
2. Select Project > Add Video(s)... !w

| Fit Window ko Conkents
| w Align Vertical
Align Horizankal

3. Browse for a video file (*.avi) or image sequence (*.bmp, * tif,
*.jpg), and click Open.

4. The video file will appear as a thumbnail in the Project Window.

Removing Videos

1. Right-click the video thumbnail you wish to remove. DitrughylickDL.avi »

Add Open Videnols) 2

Playback, 3
2. Select Project > Remove Selected Video. Fit Window £ Cantents
v Align Wertical
Align Horizonkal

3. Click YES to confirm that you would like the selected
video removed from the project.

4. The video file is no longer displayed in the Project Window.

Adding Associated Files
1. Right-click the video thumbnail for which you wish to ADD an Associated File.

2. Select <Video> > Add Associated File(s)... s '
demofiles\demo_heartvalve.avi ¥ Add Associated Filsis). .
3. Browse for an Associated File you would like to Playback Benevelisseared G I

add, and click Open.
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Launching Associated Files

Project »
1. Right-click the video thumbnail for which Eemsfitsinn Jeiieehad O
i i icti 2ature Trackin »-—*.ftk files
you WI.Sh to Iellunch an available/existing Aesosiated :ta.;“lza;m 2 b .stb files
Associated File. File Types Calbration »—*.clb files
Image Processing y-—*.imp files
2. Select <Associated File Type> > fraph Canfig b gfc files
Associated File from the pop-up menu. A '
3. The Measurement Window will appear with the Associated File selected.
Removing Associated Files

Select files to remove x|
0 4Prod

E rample Files\demofileshdemn_he

1. Right-click the video thumbnail for which you wish to
remove an Associated File.

2. Select <Video> = Remove Associated File(s)...

3. Select the Associated File(s) to remove, and click OK.



Understanding Layers

What is a Layer?

There are many different overlays that may be drawn over the video image. Controlling
the location and display of each of these items is done by using the Display Layers
control panel.

There are a number of options that can be set in this control panel:

Display Layers — The upper portion of the control panel lists whatever overlays are
currently available for drawing, this may include calibration results, analysis results,
annotations, etc. Check/Uncheck the box next to each item to have it displayed/ hidden.

& Rebeccab4sub.avi

HEOEEE IR

i Display Laper

a8

o =g

[ Thumbngi | Processed faw

=

~ Display Settings
[¥ Enable Reticke

Fieticle Position: [ #=100,¥=264
Reficle AGB: | 11,208,244
I~ Show Rulers
¥ Show ZoomBas [Upper Fight =]
I~ ShawVidealia [~ -]

Show GPSARIG Data——————
I~ Orientation ™ Trigger
I” Position I~ Time

Alve s

[FFT | Rew

i i
015 02
Time [seconds)

J44| o [ | |1 |iw|ppi| TS Sow ———}—— Fast

om0 om 014 0g¢ [nzseon  PlabeckRaio 1:1 =] frames
o 2 57 I #4wvg Playback Rate [ 200 fps
* oo |“\ ] Zein 0 Jump Zoom
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Overlay Video — Check/Uncheck this box to display a second video overlaid on the
currently active video. Click the Browse button to open a file selection window from which
you can load the video to be overlaid. The Alpha slider can be used to control the
transparency level of the overlaid video.

Enable Reticle — Check/Uncheck the box to enable/disable the reticle. When the
reticle is enabled, crosshairs will be drawn over the video image. The crosshairs will
be placed wherever the mouse is clicked in the image. The control panel displays
the coordinates and the value of the pixel underneath the crosshairs.

Show Rulers — Check/Uncheck the box to enable/disable rulers. Rulers are drawn
along the border of the video display region.

Show Zoom Box — Check/Uncheck the box to enable/disable drawing of the zoom
box when panned or zoomed. The zoom box can be drawn in any of the four corners
of the image, or may be hidden altogether. Use the drop down box to select the
location for the zoom box.

Show Video Info — Check/Uncheck the box to enable/disable drawing of
video information. The video information is a set of text that is drawn over the
video image that indicates the current frame, recorded rate, shutter speed,
etc. It can be drawn in any of the four corners of the image, or may be
hidden altogether. Use the drop down box to select the location for the video
information.

Show GPS/IRIG Data — The four different components of the
GPS/IRIG information can each be enabled or disabled

No orientation information available independently. Check/Uncheck each box to enable/disable
Lat: 0.0000, Long: 0.0000, Ait: 0.0000 drawing of the GPS/IRIG information, if present. The

No trigger time available

IR RERET AR VLR Y IR 1. GPS/IRIG information is always drawn at the bottom of the

video image.
x
Application | Open/Save Yideo/Data |Wind0w| The reticle, rulers, video information, and GPS/IRIG

information can all be turned on automatically every
time a new video window is opened by setting the
default options in the Program Options window.

~ Yideo
[” Enable reticle on open
[™ Enable rulers an open
I™" Display videa information by default In the Menu Bar, select Edit > Program Options...
[™ Display GPSARIG infarmation by default
[™ Display 16-bit TIFFs as 5-5-5 RGE color

Default 16-bit TIFF Bit Selection if Béw IBits 512 'l

M ouse wheel zoom mode:
& Point under Mouse € Reticle Point € Center of Yisw

Cancel
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The following is a breakdown of individual layers. The resulting video image would be the
previous screen picture.

1. Analysis Results (e.g. 1D Feature Tracking, 2D Feature Tracking, Stabilization,
Contour Tracking, or Particle Tracking)

2. Image Filters: A sequence of image processing filters can also be applied to the
video images

3. Calibration: Settings/ Measurements that convert and scale the recorded video
image to real-world dimensions and orientations.

4. Annotations: Video, data, and global notes and graphical annotations.

5. Graph Configuration (See Section 5): A compilation of various tracked
points/features within the video displayed on a graph.



Tracking Features and
Measuring 2-D Motion

What is Feature (2-D) Tracking?

Tracking is the ability to select a distinct feature and determine its frame-by-frame motion
characteristics (e.g. position, velocity, etc.) over time, with respect to the plane of the
image.

There are two methods available for tracking 2D motion. Automatic (Auto) Tracking
asks the user to select the feature location in a single initial frame. The feature is defined
as a rectangular region of pixels in the initial frame. Auto Tracking then does all the work
of stepping through subsequent frames, while automatically finding and tracking the
feature along the way. This method is effective for most applications.

Manual Tracking requires the user to step through the video one frame at a time, using
the mouse to select the location of the feature in each frame. This method is preferable
for low-quality images or very irregular feature paths not suitable for Auto Tracking.

A total of 64 features can be defined for tracking. Points can be defined for each of these
features using automatic tracking or manual tracking or both.
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Accessing Feature (2-D) Analysis Tools

To access the Feature (2-D) Analysis tools, click on the Feature Tracking icon 20 on
the toolbar on the left side of the Measurement Window.
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Feature Track Panel
The Feature Track Panel follows the standard layout of analysis modules.

1. Enable/Disable — The first step in any Feature Track analysis is pressing the Enable
button in the upper left of the panel. This initializes memory and sets up configuration
information. This must be done for each video that you wish to analyze. When you
are done with the analysis, you can press this button again to disable the Feature
Track analysis and free the associated memory.

2. Load - Saved Feature Track analysis files can be loaded using this button. All
tracking results and feature configuration will be reloaded from the saved file. Feature
Track files are saved with the FTK file extension.
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10.

11.

12.

13.

— Feature Track Mode 3. Save — Save Feature Track analysis
Di configuration and results to a file. All
izable | " Manual ; . .
tracking results and feature configuration
S ave | % Automatic will be saved to the file. Feature Track
files are saved with the FTK file
— Features extension.
Add | Fhar“U"El Clear | 4. Manual/Automatic Mode — Select
] i Y g Ay whether'the tracking module ghould
5 Ko g B Q, operate in Manual or Automatic mode.
— The mode only affects how new track
3| Ankle a |= a9 ) ;
1 Toe Z g a points are added to the analysis. You
, T ” E Y can switch between Manual and
orEe = Automatic mode at any time.
5. Add - Add a new feature to the analysis.
Use the Define Region and Set Region
buttons to define a template for the
Define Region Set Region | feature.
. 6. Remove — Remove a feature from the
— Feature Lines Shuw Points .
analysis. Select the feature to remove by
Configure ShC'W Al clicking on the appropriate row in the
. properties section. Then press the
7 1=k Remove button.
Track Backward | Track Fonward |
7. Clear — Clears all analysis results for the
—Expart selected features. A message box will
Pivels = | [Text *|  Esxport appear to confirm that you wish to delete
I J I J —I the track points.

Define Region — When in automatic mode, click on this button to define a region for
a feature. Click and drag a rectangle in the image to be used as a template for a
feature. After dragging a rectangle, it may be repositioned by clicking and dragging it
in the image. Click on the Set Region button when you are satisfied with the region
you have defined, or click on Define Region again to redraw another rectangle.

Set Region/Set Point — When in automatic mode, click on Set Region when you are
satisfied with the feature region you have defined after pressing Define Region.
When in manual mode, click on Set Point when the reticle is located over the point in
the image where you would like to add a tracking point.

Configure Feature Lines — Lines can be configured to be drawn between tracked
features. Click on this button to display the Line Configuration dialog.

Show Points — The track points from all frames, past frames, the current frame, or
no track points can be shown in the video.

Track Forward — Perform the automatic feature track analysis from the current frame
backward in the video. When tracking is in progress, you can click this button again
to abort tracking.

Track Backward — Perform the automatic feature track analysis from the current
frame backward in the video. When tracking is in progress, you can click this button
again to abort tracking.
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14.

The

15.

16.

17.

18.

19.

20.

Export — Exports the results for the feature tracking. The export units are specified
by the left most drop-down selection. The export format is specified using the middle
drop-down selection.

feature properties’ listing is composed of six columns...

Feature Number — Indicates the feature number. Double-clicking on this column will
also bring up the Track Settings dialog for the given feature.

Feature Label — Displays the label for the feature. The label is set in the Track
Settings dialog that appears when the Settings column is clicked.

Marker — Displays the marker for the feature. The marker can be modified by double-
clicking on this column to bring up the Marker Editor.

Visibility — Each feature can be displayed or hidden individually. Click on this column
to hide or display track points for this feature.

Lock/Unlock — Lock or unlock this feature. If a feature is locked, the tracked points
and settings will not be modifiable.

Settings — Click on this icon to show the Track Settings dialog for this particular
feature.

AUTO TRACKING

Marker Editor

The

appearance of each feature marker can be modified using the Marker Editor dialog.

This dialog appears when you double click on the marker (third column from the left) in
the feature properties listing in the control panel.
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Trac
=

Hip [+ |2 & 9 | Style — Four different marker styles are available:

Knee

Ankle F 3

Toe * x "' n

osch [\ Color — Click on the button next to the color square to bring up
the color selection dialog. Select the desired color for the

Style: marker.

Calor:

I |3-__:II || Pen Width - Sets the thickness of the lines that are used to
e = | form the markers.

Size: |3 :’ _LI

Size — Sets the overall size of the entire marker.

Sample: I:l
: ¢ |

Sample — Provides a sample of the resulting marker using the

settings that have been configured above.

Track Settings
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The Track Settings dialog can be displayed by clicking

on the Settings icon % or by double-clicking on the 1] Hip + § FIEY
feature number (1st column) in the feature properties 2 Knes -4 EIRS
listing. The Track Settings dialog is where parameters 3| Akl | & |% &R

can be set that control how automatic tracking is performed.

1. Feature Label — Enter a label for the feature that is
displayed in the feature properties listing and over the
Fleatwe Label feature region in the video image.
Hip
sge Setings 2. Show Settings — Each feature can maintain its own
ey | g — Featwe| set.of Image LUT settings. These !_UT settings are
T —— typically the settings that were active when the feature
was added. Click on this button to display the image
5;::::;;22‘:3@He{ R ?eS;?Sr;he image LUT settings associated with this
Threshold Talerance [0.0-1.0] IW )
DI o (Lt (] il 3. Apply Current to Feature — This button allows the
AT S AT L L image LUT settings for a given feature to be changed
|E i“b"’:“_e'ta“tu:w ‘r _f:hamd e to whatever settings are currently active. In order to
oA e S change the LUT settings associated with a feature,
Fe"““'e“°‘a‘§:gulamange e change the LUT settings so that the desired
I Enahle SepSesles [T appearance is achieved and then press this button.
Trajectory Prediction 4. Use image processing filters — While each feature
[~ EnableX [~ Enable¥ [ EnableR can have its own set of Image LUT settings, all
R features share the single set of Image Processing
mport Fainis | Expart Foints | Filters defined for the video. However, each feature
can be set to use the image processing filters or to not
topb | pefaut | [ Cose | use them. Check this box to have the image

processing filters applied to the video for this particular
feature when analyzing.

5. Search Radius Multiplier — Configure how large of an area to search for template
matches. This is a percentage of the initial region size that was defined for this
feature. A value of 100 (%) indicates that the algorithm should search in a region as
large as the initial region size. Larger values will result in larger search areas, which
will take a longer time to search. A typical value for this parameter is 160. This
parameter is related to the Limit on Distance From Last parameter. If you increase
the search radius, you should also increase the limit on the distance.

6. Threshold Tolerance — Configure the sensitivity of the matching algorithm. The
tracking algorithm assigns a value between 0 and 1 is given to all points within the
search region indicating how well they match the template region. All values below a
set threshold are ignored. A threshold value of 1.0 indicates that only a perfect match
will be accepted. Lower this value if the tracking algorithm fails to track a feature. A
typical value for this parameter is 0.85.

7. Limit on Distance From Last — Configure how far a track point can move from one
frame to the next, expressed as a percentage of the feature size. A value of 100 (%)
indicates that the track point can move a distance of up to the full size of the feature.
A typical value for this parameter is 100. This parameter is related to the Search
Radius Multiplier parameter. If you increase the limit on the distance, you should also
increase the search radius.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Frames to Search After Loss — Configure if the tracking algorithm should continue
to try searching for a match beyond a frame where the feature was lost. This
parameter sets how many frames the algorithm should continue beyond the frame
where it lost the feature. If the feature is found again, the tracking will continue as
normal.

Sub-pixel accuracy — Enabling sub-pixel accuracy attempts to estimate the best fit
match to the template at a sub-pixel level. This option is typically always enabled,
however, if only pixel accuracy is preferred, uncheck this option.

Enhanced match — Enabling enhanced matching attempts to improve the matching
by enhancing the template image and search region. This option is only available if
sub-pixel accuracy is also enabled. Enabling this option will increase the processing
required for tracking and may result in a noticeable increase in the time required for
tracking. Do not enable this for large search templates unless your system has a
large amount of available memory.

Enable (Feature Rotation) — Enable feature rotation when tracking. The algorithm will
try comparing rotated versions of the template with the search region to find a match.
The best match over all the rotation range will be returned as the final match.

Angular Range — The rotation range in degrees to search for matches. The template
will be rotated plus or minus this value in degrees in intervals of the step size.

Step Size — The step size to use over the rotation range to search for matches. For
example, a rotation range of 10 degrees with a step size of 1 will examine the range
of -10 to 10 degrees in 1 degree increments.

Enable X Trajectory Prediction — Enable trajectory prediction in the horizontal
direction. The trajectory is predicted using an estimated velocity and acceleration of
the previous track points. The search area is then centered on the predicted location
(rather than the last location). Enabling prediction will allow you to reduce the search
radius multiplier for faster searching.

Enable Y Trajectory Prediction — Enable trajectory prediction in the vertical
direction. The trajectory is predicted using an estimated velocity and acceleration of
the previous track points. The search area is then centered on the predicted location
(rather than the last location). Enabling prediction will allow you to reduce the search
radius multiplier for faster searching.

Enable R Trajectory Prediction — Enable trajectory prediction for rotation. The
trajectory is predicted using an estimated velocity and acceleration of the previous
track points. The search area is then centered on the predicted location (rather than
the last location). Enabling prediction will allow you to reduce the search radius
multiplier for faster searching.

Import Points — This button allows you to import tracking points from a text file that
will be added to the currently active feature. These track points are treated as if they
were manually placed by the user. The text file must be formatted such that each line
contains on X value, followed by a comma, followed by a Y value. All values must be
in declared in pixel coordinates, with the origin in the upper left or the screen, and the
X-axis running to the right, the Y-axis running down.

Export Points — This button will export any tracking data associated with the
currently selected feature to an external text file, formatted as described above.
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19. Apply — Apply the settings to the feature. Changes will not be applied unless this
button is pressed.

20. Default — Load the default settings for the feature properties into this dialog. The
settings are not applied until the Apply button is pressed.

21. Close — Close the dialog. Settings will not be applied unless the Apply button was
pressed.

MANUAL TRACKING
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Adding and Removing Points

Manual tracking is performed on a per-frame basis; the user cycles through each relevant
frame and manually marks the feature locations by clicking the mouse. Manual tracking
mode is selected by clicking on the Manual mode in the upper left corner of the Feature
Tracking control panel.
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To manually ADD a point or to MODIFY the location of a
point:

1. Select the feature in the feature properties list that you wish to add a track point to by
clicking on the corresponding row.

2. Click in the image window to place the reticle in the desired position.

3. Click on the Set Point button in the Feature Tracking control panel or hold down
the Control key and right-click.

To REMOVE a point:

1. Right-click inside the Measurement Window to open a pop-up menu.

2. Select Feature Tracking - Clear Features - < delete option >.

Automatic Advance

When doing manual tracking, using the automatic frame and feature advancing features
are very helpful in speeding up the process. These features when enabled will
automatically advance to the next unlocked feature after you have set a point manually. If
the current feature is the last feature in the list, then the frame will advance to the next
frame and the feature will be set to the first unlocked feature.

To ACCESS the Automatic Advance features:

1. Right-click inside the Measurement Window to open a pop-up menu.
2. Select Feature Tracking = Auto-Advance - < advance option >.

If automatic feature advancing is enabled without automatic frame advancing, then
when the last feature is reached, the feature will stop advancing. If automatic frame
advancing is enabled without automatic feature advancing, then the frame will only
advance when you set a point for the last feature in the list.

Other Operations

Line Configuration

Once features have been tracked, lines can be configured to be drawn between features.
These lines are configured by clicking the Configure button in the Feature Lines section
of the Feature Tracking control panel to open the Line Configuration dialog.
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To ADD a new line:
=l 1.

Click on the Add Line
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button.

Select whether you
want the line to be
drawn in the currently
displayed frame only,
past frames, all frames,
or in none of the
frames. Also, select
whether you would like
to highlight the line in
the current frame. This
is useful for
distinguishing the line
in the current frame
from the other lines in
past or all frames.

Set the line style, color,
and thickness (size).

4. Select which points should be connected by the line. All possible features and points
are listed in the left column. Select which points to add and hit the right arrow =
button. The left arrow €/ button can be used to remove selected points from the right
column. The up and down arrows allow you to reorder the sequence of points in the

line.

5. Lines can also be configured to display active measurements of the angle between
line segments or the lengths of line segments. Select whether you wish to have angle
or length dimensions drawn with the lines.

6. If measurements are enabled, configure the units, and appearance of the

measurement label.

7. Click the Apply button to apply the changes.

To MODIFY the properties of a line:

Select the line number that you wish to modify in the top drop down box. Make the
changes, and then click the Apply button.
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To REMOVE a line:

Select the line number to remove in the top drop down box. Click the Remove Line
button.

Line configurations are saved with the entire Feature Track settings when stored to a file.
They will be automatically restored when the saved file is reloaded.

Measurements

Immediate simple measurement results such as position and velocity can be displayed for
each feature using the Measurements Window associated with a video window.

Click on the Show Measurements icon " on the top of the Measurement Window to
display results.

1B
+ - | ) | Units: IPierS vI

|dentifier | Position [.7] | Digtance from Origin | Dizplacement | Speed |
Feature 1 Hip] 251,130 282 668 4 1000

Feature 2 [Knes] 138. 236 308.058 4123 1030.78

Feature 3 [fnkle] 136, 361 410,776 2.23607 559.07

Feature 4 [Toe) 142, 365 391.649 5.03302 127475

Feature 5 [Torzo) 250, 32 252.04 6.32456 1581.14

Exporting Tracking Results

After a successful track is completed, you can export the data to a variety of formats to
perform any additional custom analysis or graphing.

£ Units — You can select what set of units to use for
sl exporting the tracking results. If no calibration has
’7| Fiiels j ITEHt j ﬂl been done on the video, then this selection is
ignored and the values are output in Pixels.

Format — Select an output format: Text, Excel Blank, Excel Template, or Diadem. Results
for feature tracking will be exported to the resulting file.

The feature track data is composed of the following information: frame number, time (if
we know the record rate of the video), and the X and Y coordinates of each of the
tracked feature points.

The Excel Blank and Excel Template options both export the same data. However,
Excel Template exports the data into an existing Excel file that is used as a template. Any
formulas and graphs in the template file will be recomputed and regenerated for the
exported data.
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Export — When you are satisfied with your tracking results, and have selected your export
units and format, click on the Export button to export the results.

Graphing Tracking Results

Feature tracking results can be immediately displayed in the Measurements Window
graph section. One tracking is complete, use the Graph Configuration control panel to
add feature tracking results to the graph section.

Measurements and tracking information can be added to a graph in much the same way
that new items are added for feature tracking. Clicking the Add button will bring up a
dialog box which displays every item that can currently be graphed, sorted by module.
Click the check box next to the measurement you wish to add to the graph and press the
OK button. The graph will automatically update to display the newly added items. To
remove a graph line, select the item from the Graph Lines list and click the Remove
button.
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Saving and Loading

All Feature Track settings and results can be saved to a file for later use. This allows you
to do multiple analyses on the same video file, store the configuration and results, and
later load the appropriate analysis whenever you need it. Feature tracking settings saved
from one video can also be loaded on another video. This allows you to configure
features and settings for one video, then load and apply these settings to any other
videos in which the same type of analysis is to be conducted.
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Select Destination for Track File @
Savein | 3 nunning = ex B2
[CRebeccal4sub_imgs
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To SAVE the analysis settings and results, click
the Save button at the top of the Feature
Tracking control panel. Feature Track settings and
results are stored to files with the FTK file
extension.

If you only want to save the feature settings,
uncheck the “Save track points” checkbox in the
Save Options. This is useful if you intend to use
this file to define feature settings for different
videos.

To LOAD a saved analysis file, click the Load
button at the top of the Feature Track control panel.

Uncheck the “Load track points” checkbox in the
Load Options if you do not want to load the track
points stored in the file. This is useful if you only
want to use the feature settings contained in a
track file that may have been saved from a different
video.

Check the “Append” checkbox to append the
tracking points in a file onto the existing video. This
allows you to compare tracking points from
different analyses on top of each other.



Annotating Measurements

Video and Data Notes

The Notes control panel allows you to enter comments for each video frame and each
data point in an event. It also allows for one global comment for the entire event. These
comments are stored in a binary file along with other data such as GPS/IRIG information.

The Notes control panel is composed of five (5) sections:
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1.

Show Notes — Check boxes to selectively
display the video, data or global comment
fields. Each of these boxes can be
selectively displayed or hidden so that the
remaining boxes have more room to
display their contents. To enable or disable
display of each item, check the check box
next to each type. For comments that are
larger than the text box, tooltips are also
provided. When the mouse is moved over
each of the boxes, a tooltip window will
appear displaying the full contents of the
text box.

at Data Indeypata Index 625 MNokes:

ot whesasonginal Graph windaw.

acceleramets The wall accelerometer (Channel 13 starts ko record impact
motion until 4 at Data Index 625, OF particular note is that the windshield
millizecond 14 accelerometer (Channel 0, green line) does nok show any
mokion unkil approxirmately Data Index 639 -- over a Full

4 | millisecond later, This is due to the energy absorbed by the car.

— Global Maotes|Goko Data Index 641 by using the single skep buttans on

2. Step — To review
comments saved with
an image sequence or
with a data sequence,
simply click on left
arrow button or right

Test Surmary

A& model car was instrumented with ar

& second accelerometer was placed
The car, which had a spring start, wa: =
4 | | »

arrow button. You will
be automatically advanced to the next
sequential comment (video or data). The
corresponding video frame or data point
will automatically be displayed.

This provides an easy mechanism for stepping
through your measurement to find all frames

and data points that have been marked with notes.

3. Video notes — These comments are saved for each frame of video.

4. Data notes — These comments are saved for each data point in the data

sequence.

5. Global notes — These comments are free form - not assigned to any particular

frame or data point
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Graphical Annotations

Graphical annotations allow you to draw lines and text and other objects directly on the
video images. These annotations can be made so that they only display on specific
frames or they can be set to always display on all frames.

The annotations controls are available on the application toolbar or in the Annotations
control panel in the main video window as shown.
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Standard Annotations

In this section, the standard annotations, settings, and visibility tools are documented.
There are also two special annotations that can be used to perform static length and
angle measurements. The standard annotations available are:

— Annotations

Lal[~]

N ol ef vl vl al
S| m| e w| v m

to create new annotations.

1.

Lock Annotations — Lock annotations so
that they cannot be modified.

Select Annotations — Mouse clicks will
select and drag any existing annotations.
This is the default mode. Select Lock
Annotations to prevent any mouse
interactions from modifying existing
annotations. Select any of the other buttons

3. Draw Line — Start drawing a line in the Measurement Window.

4. Draw Arc — Start drawing a three-point arc in the Measurement Window.
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5. Draw Rectangle — Start drawing a rectangle in the Measurement Window.

6. Draw Filled Rectangle — Start drawing a filled rectangle in the Measurement
Window.

7. Draw Ellipse — Start drawing an ellipse in the Measurement Window.
8. Draw Filled Ellipse — Start drawing a filled ellipse in the Measurement Window.

9. Draw Polygon — Start drawing a polygon in the video window. Each mouse click will
add another point to the polygon. End the polygon by right-clicking on the last point.
Points may be added and removed from a polygon by using the Insert and Delete
keyboard keys when the mouse is over a drag handle.

10. Draw Filled Polygon — Start drawing a filled polygon in the video window. Each
mouse click will add another point to the polygon. End the polygon by right-clicking
on the last point. Points may be added or removed from a polygon by using the
Insert and Delete keyboard keys when the mouse is over a drag handle.

11. Draw Spline — Start drawing a spline in the video window. Each mouse click will add
another point to the spline. End the spline by right-clicking on the last point. Points
may be added or removed from a polygon by using the Insert and Delete keyboard
keys when the mouse is over a drag handle.

12. Draw Filled Spline — Start drawing a filled spline in the video window. Each mouse
click will add another point to the spline. End the spline by right-clicking on the last
point. Points may be added or removed from a polygon by using the Insert and
Delete keyboard keys when the mouse is over a drag handle.

13. Draw Text — Start drawing text in the video window at the location of the next mouse
click.

14. Draw Filled Text — Start drawing text with a filled background at the location of the
next mouse click.

Default Settings

The default settings for newly created annotations can be set using the Default Settings
portion of the control panel.

Foreground Color — Sets the default foreground
color for all new annotations. Click on the colored

|:|| Foreground Color button to display a color selection popup window.

— Default Sethings

Background Color — Sets the default background
color for all new annotations. Click on the colored

.l Tenwt Colar button to display a color selection popup window.
= |

Background Color

Default Settings Text Color — Sets the default text color for all new
annotations. Click on the colored button to display
a color selection popup window.
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X

— Color

Line Color |:|| [T Closed

Fill Calar — R T

Text Color _l

. Default Settings — Displays a default settings
[ rRestanse dialog where the default colors, line styles, and

Line Thickness  [3 2] anowHead font styles may be set for all new annotations.

Line: Style Soid x| [ AnowTai To modify the settings of an existing

annotation, double-click on the annotation in

—— the video window.

|

Fot  [pid ] [ Eod

™ Italic
Font Size 18 = RPaeine

Apply | Dismiss |

Visibility Settings

The visibility settings for the selected annotation or all annotations can be set using the
Visibility portion of the control panel.

1. Show/Hide Annotations — Shows/hides all
— Y izibility annotations for the active video.

s | wr | w 2. Show/Hide Drag Handles — Shoyvs/hldes the
square drag handles used to modify annotations.

B | Ty 3. Show in Current Frame — Set the currently
selected annotation to display only in the current

4. Show in All Frames — Set the currently selected
annotation to display in all frames.

5. Bring Forward — Move the currently selected annotation forward in the display
order.

6. Bring to Front — Move the currently selected annotation to the top of the display
order.

7. Send Backward — Move the currently selected annotation backward in the
display order.

8. Send to Back — Move the currently selected annotation to the back of the
display order.

9. Delete Annotations in Current Frame —Delete all annotations for the current
frame only. Does not delete annotations that are set to display in all frames.
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10. Delete All Annotations — Delete all annotations for the active video.

Properties
x|| If you double-click on an existing annotation, the
~ Colar annotation properties dialog will appear.
Line Colar " Closed

_ {—] For different types of annotations, different

gl  —1 R properties will be available to be modified. Make

LTI W— the desired changes and press Apply to apply
them to the drawing. Click OK when you are

satisfied, or Cancel to cancel your changes.

—Appearance

Line Thickness e | frravs Head

Line Style ISoIid [ = Ao Tiail

 Text

ITest Swing #1
Fant IHaettenschweiIer vl [ Bod

IV Italic
Fant Size 18 > v Underline

Apply | Dizmizs |

Deleting Annotations

Click on the annotation that you wish to delete. The annotation should be highlighted in
yellow. Click the Delete key on the keyboard and the annotation will be deleted.
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Moving and Adding/Removing Points

1. Every annotation has "handles". The location 2. Click and drag the handle to move it to
of these handles may be modified to change another location.
the shape or position of each annotation.
When the mouse passes over a handle, the
handle should become highlighted in red.

3. For annotations that support an arbitrary 4. A new point (handle) will be added on the
number of points (polygons, splines), new segment that is closest to the current mouse
points can be added by selecting the location. To remove a point, move the mouse
annotation and pressing the Insert key on over the point (handle) that you wish to
the keyboard. remove. Make sure that it is highlighted in

red, then press the Delete key. Be careful,
this only works for polygons and splines and
only if a drag handle is highlighted. If you hit
Delete for any other type of annotation or not
over a highlighted drag handle, the whole
annotation will be deleted.
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Static Measurements

There are two special types of annotations that perform basic dimensioning functions.
These are the length and angle dimension annotations. They are located in the middle of
the Annotations control panel and on the Annotations toolbar

Dimensions Draw Length Dimension — Start drawing a static length dimension in the

ﬂl il video window. The length dimension will be shown in the units that the
video was calibrated in. If no calibration has been applied, the length
dimension is shown in pixels.

Draw Angle Dimension — Start drawing an angle dimension in the video window. The

angle is defined by the location of the next three mouse clicks in the video window. The
angle measurement is shown in degrees and is the angle between the lines connecting
the first and last point to the middle point.

Angle Dimension
The angle dimension annotation provides a simple means for measuring an angle in the
video image. The units for the angle dimension are always given in degrees.
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To draw an angle dimension:

1. Click on the Draw Angle Dimension button 4| on the annotation toolbar or
control panel.

2. Click on the first point in the image (ankle).

3. Click on the second point in the image which will be the center of the angle
(knee).

4. Click on the third and final point in the image (hip).
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5. Click and drag any of the drag handles to fine tune the location of the angle
dimension.

6. Double-click on the new angle dimension and modify any settings if necessary.

Length Dimension

The length dimension annotation provides a simple means for measuring a length in the
video image. The units for the length dimension will be given in the same units that were

us
un

ed for calibration. If no calibration has been done, the length dimension will be given in
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To

1.

draw a length dimension:

Click on the Draw Length Dimension button ﬂ on the annotation toolbar or control
panel.

Click and hold down the mouse button starting at one end point of the length you
wish to dimension.

Drag the mouse and release at the other end point of the length you wish to
dimension.

Click on the additional drag handle at the end of the dimensioning line (shown in red
here) and drag the dimensioning line to the desired position.

Click and drag any of the drag handles to fine tune the location of the length
dimension.

Double-click on the new length dimension and modify any settings if necessary.



Tracking and Measuring 1-D
Motion

Line (1-D) Tracking

The Line Tracking control panel enables you to do automatic one-dimensional (1-D)
motion tracking. This analysis module allows you to place up to 64 lines in arbitrary
locations within your video frame and detect motion that match a given set of user-defined
criteria.
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The Line Tracking module is capable of detecting peaks in intensity or derivative of
intensity along a line and detecting points of transition that exceed a configurable
threshold value for intensity or derivative of intensity. You can limit your search to black-
to-white transitions or white-to-black transitions or search for both. Up to 20 targets that
satisfy the specified criteria can be found for each line in each frame of your video.

The Line Tracking control panel can also use the resulting data to compute a best-fit
circle. A fixed center point for the circle may be specified, or a least-squares optimization
method can be used to find the best center location.

The resulting line and circle information can be exported to Excel for reporting or more
exhaustive analysis. The video scene scale and orientation can be calibrated to use real
world units that can be used when exporting.

In this next image, the Line Tracking module is used to find the leading edge of a flame
front that is expanding out from the center. The lines are set to detect changes in intensity
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from black to white to detect the edge of the flame. A circle fit is also enabled to estimate

the radius of the flame front.

Many tools for enhanced visualization of line information are provided. The Line View
window provides instant feedback for configuring the location, threshold, thickness, and
other settings that will produce the best results for your tracking needs. The Summary
View generates a bitmap image of the pixels or their derivative along a given line as a
function of time, giving you a snapshot of your complete video in a single image.

Line Tracking Panel

The Line Tracking Panel follows the standard layout of analysis modules.

Line Tracking

Line Tracking

Dizable
Load Save
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[+ Circle Fit
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v Automatic

Remowe |

ol |- i
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:

Lo kol —
[ ]

dyayay
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Cir. | O

Madify Line | Set Line

Feature Lines

Configure

Tracking
Track Backward | Track Forward ‘

ﬂ E sport

Dizplay
[ Line Legend
[ Surmmary Marks

Unitz & E=port

| Pixels j | Text

Brief summary of the various controls on this panel:

1.

Enable/Disable — The first step in any line tracking
analysis is pressing the Enable button in the upper left
of the panel. This initializes memory and sets up
configuration information. This must be done for each
video that you wish to analyze. When you are done
with the analysis, you can press this button again to
disable the line tracking analysis and free the
associated memory.

Load — Saved line tracking analysis files can be loaded
using this button. All tracking results except for the
summary view contents will be reloaded from the saved
file. Line tracking files are saved with the LTK file
extension.

Save — Save line tracking analysis configuration and
results to a file. All tracking results except for the
summary view contents will be saved to the file. Line
tracking files are saved with the LTK file extension.

Circle Fit — Enable circle fitting for this analysis. This
will add another row, labeled 'Cir.', in the Properties
section of the panel through which the circle fitting
parameters can be set.

Manual/Automatic Mode — Select whether the
tracking module should operate in Manual or Automatic
mode. The mode only affects how new track points are
added to the analysis. You can switch between Manual
and Automatic mode at any time.

6. Add - Add a new line to the analysis. The line will be added in the default location
(horizontal across the center of the video). Use the Modify Line and Set Line buttons
to change the location of the line.

7. Remove — Remove a line from the analysis. Select the line to remove by clicking on the
appropriate row in the properties section, and then press the Remove button.
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10.

1.

12.

13.

14.

15.

Clear All — Clears all analysis results for all lines. A message box will appear to confirm
that you wish to delete all analysis results. The line locations and properties will remain
the same.

Modify Line — Modify the location of the line in the video. Press this button and then
click and drag the mouse over the video image at the location where the line should be
placed. If you would like to keep one endpoint fixed and modify the other, you can
move your mouse over the endpoint (marked P1 or P2) and drag just that end point to a
new location. When you are satisfied with the line that you have placed, click on the Set
Line button.

Set Line — This button is only used to complete a Modify Line operation. Click on
Modify Line and set the line location as desired, then press Set Line to accept the new
location of the line.

Line Legend — When enabled, displays a legend in the upper left corner of the video
image indicating the coordinates of each of the analysis lines.

Markers in Summary View — When enabled, red markers will be displayed in the
Summary Views to show the location of the tracked points on each line. Since the
Summary Views are regenerated each time a video is tracked, you must re-track the
video in order for a change to take effect.

Track Backward — Perform the line tracking analysis from the current frame backward
in the video. When tracking is in progress, you can click this button again to Abort
tracking.

Track Forward — Perform the line tracking analysis from the current frame forward in
the video. When tracking is in progress, you can click this button again to Abort
tracking.

Export — Exports the results for the line tracking and circle fit. The export units are
specified by the left most drop-down selection. The export format is specified using the
middle drop-down selection.

The properties listing is composed of seven (7) columns.

12 3 4 56

1 =2 MO
2| |®mo Mo
Ci. | ©

Line Number/Circle — Line number or circle
indicator for each line. Double-clicking on this
@, column will also bring up the settings dialog
Y for the given line or circle.

:

LAL A
> i

Line Color — Each line is automatically assigned a color when added, however, if
you wish to change the color for any reason, click on this column and a color
selection dialog will appear.

Line View — Click on the check box next to the graphic icon to display the line view
for the given line.

Summary View — Click on the check box next to the graphic icon to display the
summary view for the given line.

Visibility — Each line can be displayed or hidden individually. This does not affect
whether or not a line is used in tracking (for that, use the Active check box in the
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settings dialog). This setting only affects whether or not the line is drawn in the
image.

6. Lock/Unlock — Lock/Unlock this line. If a line is locked, the tracked points and
settings will not be modifiable.

7. Settings — Click on this icon to show the settings dialog for this particular line or
circle.

Line Properties

The Line Properties dialog allows configuration of how tracked points are determined for
each line. The Line Properties dialog is accessed by double-clicking on the line number or

clicking on the 9 jcon in the Properties section of the Line Tracking control panel.

— Image Settings : 1. Show Settings — Each line can maintain
its own set of Image LUT. These LUT
settings are typically the settings that

W' Use image processing fiters were active when the line was added.
Click on this button to display the image
using the image LUT settings associated
with this line.

{Show Settingzi|  &pply Cument to Feature |

— Search Parameters
v Active [~ &pply Settings to &1l Lines

Search Tupe IThresh Derivative 'I

Transition Typs W 2. Apply Current to Feature — This button

allows the image LUT settings for a given
Threshold [3 line to be changed to whatever settings

Maw. Targsts [1 - are currently active. In order to change
Thickness |3 vl the LUT settings associated with a line,

Fiter Cosfficiant 100 chapge the LUT setti.ngs so that the
desired appearance is achieved, and then
press this button.

Apply | Drefault | Dizriss |

3. Use image processing filters — While each line can have its own set of Image
LUT settings, all lines share the single set of Image Processing Filters defined for
the video. However, each line can be set to use the image processing filters or to
not use them. Check this box to have the image processing filters applied to the
video for this particular line when analyzing.

4. Active — This box indicates whether or not this line will be included in the tracking.
If the line is not active, no points will be tracked. This is useful if you wish to
temporarily disable a line without having to remove it.

5. Apply Settings to All Lines - If this box is checked, then any modifications you
make to the line properties will be applied to all lines that are currently present. Any
lines that are added later will not automatically have these settings. Instead, newly
added lines will start off with the default properties.

6. Search Type — There are four (4) possible search types:

o Peak Intensity — The peak intensity setting returns the point of highest intensity
along the line.
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Peak Derivative — The peak derivative setting returns the point of highest
derivative along the line. These two settings always return a single target. The
threshold value is not applicable for these search types.

Threshold Intensity — The threshold intensity and threshold derivative settings
require a threshold value and can return multiple matches for each frame. For
threshold intensity, the search will return points where the pixel intensity crosses
the threshold value in either the positive or negative direction or both depending
on the transition type selected.

Threshold Derivative — For the threshold derivative, the search will return
points where the magnitude of the derivative (change in pixel intensity) exceeds
the specified threshold. The threshold will apply to positive or negative derivative
values or both depending on the transition type selected.

Transition Type — There are three (3) possible transition types:

Black to White — For the threshold intensity search type and a black-to-white
transition type, the program will search for points where the intensity value
crosses the threshold value from a darker pixel to a lighter pixel. For white-to-
black transitions, the program will search for points where the intensity value
crosses the threshold value from a lighter pixel to a darker pixel. If a selection of
both is made, then both darker-lighter and lighter-darker threshold crossings will
be found.

White to Black — For the threshold derivative search type and a black-to-white
transition type, the program will search for points where the derivative (change in
intensity) exceeds the threshold in the positive direction. This is because a
black-to-white transition would have a positive derivative value. For a white-to-
black transition type, the program will search for points where the magnitude of
the derivative (absolute value) exceeds the threshold in the negative direction,
since white-to-black transitions would have negative derivative values.

Both — If a selection of both is made, then the program searches for any points
where the absolute value of the derivative exceeds the threshold. Not all points
that exceed the threshold are returned, only the points at which a transition is
made from before the threshold to beyond the threshold.

Threshold — The threshold value is used for the threshold intensity and threshold
derivative search types. In general, the threshold value is always positive and the
transition type dictates which direction of crossing is examined for intensity and
which sign of the derivative is examined. See the previous section on transition
type for more details.

A negative threshold does not make sense for a threshold intensity search type.
However, for the threshold derivative search type, one case in which the threshold
value could be negative would be if your image had regions of large derivative and
you wish to find regions of small derivative. For instance, if the derivative along a
line is primarily negative and then approaches zero in the region of interest, you
could select a black-to-white transition type and specify a negative threshold value.

The Line View window discussed in this section will greatly aid in specifying an
appropriate threshold value for each case.
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9.

10.

11.

12.

13.

14.

Max. Targets — The maximum targets setting specifies how many matches should
be detected for each line in each frame. The value can range from 1 to a maximum
of 20. For the peak intensity and peak derivative search types, only a single point
can be returned. Therefore, the Max Targets setting is only applicable for the
threshold search types. In the threshold cases, multiple points may satisfy the
threshold and transition criteria. The setting of maximum targets allows you to limit
your consideration to a fixed number of points.

Thickness — Two techniques are provided to handle noisy image data. The
thickness of each line is configurable, up to a maximum width of 20 pixels. The
program will average the pixel values along a direction perpendicular to the line. In
addition to specifying thickness for each line, you are also able to specify the
coefficient for a first order filter that is applied to smooth the pixel data before
processing.

The thickness of each line can be set from between 1 and 20 pixels. Increasing the
thickness of a line can be used to smooth the intensity values used by the program
for detecting transitions. For a line thickness greater than 1, the intensity value for
a given point is computed as the average of the intensity values at neighboring
points along a line perpendicular to the P1-P2 line. The thickness of the line
governs how many neighboring points to use when computing the average.

The thickness of the line drawn in the video image will reflect the actual thickness
setting. You can use this to visualize which pixels will be used for the averaging
computation.

Filter Coefficient — Two techniques are provided to handle noisy image data. The
thickness of each line is configurable, as described above. In addition to specifying
thickness for each line, you are also able to specify the coefficient for a first order
filter that is applied to smooth the pixel data before processing.

The filter coefficient provides another means to smooth the pixel data prior to
searching. The filter is a first-order filter applied to the intensity values from P1 to
P2. A value of 1.0 produces the exact unfiltered intensity values. Values less than
1.0 will smooth the data and values greater than 1.0 will introduce more noise.

Apply — Apply the settings to the line or all lines. Changes will not be applied
unless this button is pressed.

Default — Load the default settings for the line properties into this dialog. The
settings are not applied until the Apply button is pressed.

Dismiss — Close the dialog. Settings will not be applied unless the Apply button
was pressed.



Chapter 6: Tracking and Measuring 1-D Motion 45

Circle Properties

The Circle Properties dialog allows configuration of the circle fit. The Circle Properties
dialog is accessed by double-clicking on the "Cir." label or clicking on the wrench icon in
the Properties section of the Line Track control panel. To enable circle fitting, check the
Circle Fit box in the upper left of the Line Track control panel.

Circle Fit Settings | Use Lines — Not all of the lines that
- have been added may be intended for
& s i Ling 1 use by the circle-fitting algorithm. You
Line 2 can selectively choose which lines will
" Select > Line 3 be used by checking the appropriate
c boxes. If not all the lines will be used,
enter Tupe
_ : you must uncheck the 'Use All' box
" Fived G Firer Deriter before un-checking the boxes for the
{* Best Fit IV Sticky Center lines that will not be used.
- Properties Fixed Center — When computing the
¥ Active best-fit circle, a fixed center location can
Sdcimsarrn [ 3] || b lseorsvrebiecotrcn e
Thickness [ [~ algorithm tries to find the best radius that
will fit all the points.
Apply | Lighz | Llksicks I The fixed center will default to the center of

the video image. If a different center should
be used, click your mouse in the video image
at the desired point and then click on the Set Center button. A red '+' mark will be
shown when the fixed center type fit is being used, to indicate the location of the
center.

Best Fit Center — When using three or more lines, the best location (in a least-
squares sense) for the center and the corresponding value for the radius of the circle
can be computed for each frame. A gradient descent approach is used to compute
the location of the center and the radius.

When using the best-fit center, the quality of the line track results will greatly affect
the circle-fitting algorithm. For instance, if you are using three lines and at a particular
frame only two of the lines found suitable transition points, then best-fit circle for two
points would place the center at their midpoint and have a radius of half the distance
between them. This will likely be nowhere near the center found for the case when all
three lines found suitable transitions. For these situations, it may be helpful to check
the “Sticky Center” box. When this is checked, if the number of transition points drops
from three or more down to two or one, then the previously computed center is used
as if it were a fixed center until three or more transition points are found again.

Active — The circle-fitting algorithm can be activated or disabled using this checkbox.
If the circle fitting is disabled, then new fit values are not computed during tracking.
Any prior circle fit values or circle fit settings will remain. This is equivalent to locking
the circle in the Line Tracking control panel.

Selection Scheme — When multiple targets are available for a given line, the circle-
fitting algorithm must decide which among these multiple targets to use for the fit.
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There are four (4) different possible techniques for the algorithm to use in selection.
These are:

¢ Smallest Radius — The Smallest Radius option would select the point that is
closest to the last computed center.

e Largest Radius — The Largest Radius option would select the point that is
farthest from the last computed center.

e Closest to Previous — The Closest to Previous option would select the point
that is closest to the last point that was selected for this line.

¢ Closest to Predicted - The Closest to Predicted would use the selected points
from the last frame and the frame before to predict where the point would be in
the current frame and then selects the point which is closest to this prediction.

6. Thickness — This option allows you to specify how thick the circle is drawn. It is only
used for visual representation of the resulting circle and has no impact on any part of
the algorithm.

7. Apply — Apply the settings to the line or all lines. Changes will not be applied unless
this button is pressed.

8. Default — Load the default settings for the line properties into this dialog. The settings
are not applied until the Apply button is pressed.

9. Dismiss — Close the dialog. Settings will not be applied unless the Apply button was
pressed.

Line View

The Line View provides valuable information for selecting appropriate line properties to
produce the best tracking results. There are separate Line View windows for each line.
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Across the top of the window, the line view shows the coordinates of the end points P1
and P2 and basic statistics for slope, angle, and length of the line. The slope is the
change in X divided by the change in Y from P1 to P2. The angle is the angle relative to
horizontal, with 0 degrees corresponding to P2 located to the right of P1. The length is the
length of the line from P1 to P2 in pixels.

The main portion of the line display window is a graph of the intensity and derivative of
the pixels of the image corresponding to the particular line. The Display selection beneath
the graph allows you to select whether to view just the intensity, derivative, or both. The
units for intensity are along the left side of the graph and the units for derivative along the
right. The threshold line is shown as a red dashed line.

Two check boxes are provided to display the pixels values and to use a black
background. Displaying the pixel values will draw the intensity values of the pixels
corresponding to the line in the rectangular bar above the main graph. The intensity
values used are values after the averaging from the thickness of the line and after
filtering. Use the “Black Background” option if you have chosen a light color for your line
which is difficult to see with the white background.

To aid in visualization, you can change the vertical scale of the main graph by clicking on
the graph and either rolling your mouse wheel or pressing A or Z on your keyboard. You
can pan the graph in the vertical direction by either clicking--and-dragging with your left
mouse button, or pressing S and X on your keyboard. Double-clicking in the graph
window will reset the zoom and pan to the default values.

Summary View

After (or during) a tracking run, you can bring up a Summary View for each of the lines.
The Summary View contains images that are composed from the intensity and
derivative values under the line for each frame in the video.

U | e || =
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One axis represents the pixels from P1 to P2 and the other axis represents frame number
(or a measure of time). If you have selected Markers in Summary View in the Line
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Tracking control panel, then red pixels will be drawn at the locations where points were
found that match your specified transition criteria.

All options for the Summary View are accessed via the toolbar or context menu. You
can bring up the context menu by right-clicking in the window. The same options are
available from both the toolbar or context menu:

1. Show Intensity — View the intensity summary image. Each line in the image
represents the value of the pixels underneath the line in each frame of the video.

2. Show Derivative — View the derivative summary image. Each line in the image
represents the derivative of the pixels underneath the line in each frame of the video.

3. Show Rotated — View the image as pixels versus frame number or frame number
versus pixels.

4. Show Axis Labels — Shows or hides the axis labels shown in green at the left and
bottom of the image.

5. Make Pixels Square — The summary view window can be resized arbitrarily. This will
sometimes distort the pixels so that they are rectangular, not square. Pressing this
button will use the current width of the window and adjust the height of the window
such that the pixels are drawn square. Note that this may result in the window being
resized off the bottom of the screen. In this case, either drag the window to a smaller
width and perform this operation again or rotate the image and then make the pixels
square.

6. Save Image to File — Use this button to save the currently displayed image can to a
bitmap file.

The summary view can be a useful tool for analyzing tracking results. For instance, in the
previous image, the flame front edge is shown by the red markers. We can measure the
angle of the line formed by the markers to estimate the velocity of the edge. We can also
note that the red markers form nearly a straight line in the center of the image, but deviate
from the line at the beginning and end. This indicates that the edge is speeding up or
slowing down during those periods.

Tracking

After lines have been placed and properties defined, in order to obtain results, tracking
must be run. All tools described so far are used for setting up the parameters for tracking
but do not actually execute any of the line search or circle-fitting algorithms.

circle properties, click on the Track Forward
or Track Backward button to begin tracking.
Tracking will commence from the currently
displayed frame until the end or beginning of the video. When tracking is running, the
track buttons will change to an Abort button. Clicking on Abort will stop the tracking.

Tracking When you are satisfied with your line and
’7 Track Backward Track Forward

Since tracking begins from the currently displayed frame, in most situations, you will want
to jump to the first frame of the video before beginning tracking. You can do this by
clicking on the double-backward arrow button 144 in the Play Controls.
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If you begin tracking forward from an intermediate frame of the video, all tracking results
prior to that frame will be preserved. In this manner, you can use one set of tracking
parameters for the first portion of a video and a different set for the second portion. The
same principle applies to tracking backward from the current frame.

Saving and Loading

All line tracking settings and results can be saved to a file for later use. This allows you to
do multiple analyses on the same video file, store the configuration and results, and later
load the appropriate analysis whenever you need it. Line tracking settings saved from one
video can also be loaded on another video. This allows you to configure the line track
lines and settings for one video, then load and apply these settings to many more videos
where the same type of analysis is to be conducted.

Select Destination for Line Track File 2lx|

Save jr: Ia flame j - £ -
carmbustion, lkk

File name:

Save I
Save astype: [Line Track Files [tk | Cancel |

" Save Optiohs

¥ Save track points

4

To SAVE the analysis settings and results, click the Save button at the top of the Line
Tracking control panel. Line tracking settings and results are stored to files with the LTK
file extension.

To SAVE THE FEATURE SETTINGS ONLY, uncheck the “Save track points” checkbox
in the Save Options. This is useful if you intend to use this file to define line and circle
settings for different videos.

1% To LOAD a saved analysis file_, click the
Load button at the top of the Line
Lock jn: | 3l flare x| « BerE- Tracking control panel.

combustion, [tk

File name;

Open |

Files of type: [Line Track. Files [*Itk)

j Cancel |

Load Option
’7 [V Load track paints

To LOAD A SAVED ANALYSIS FILE
WITHOUT THE TRACK POINTS,
uncheck the “Load track points”
checkbox in the Load Options. This is
useful if you only want to use the line
and circle settings contained in a track
file that may have been saved from a
different video.
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Export

After a successful tracking run, you can export the data to a variety of formats to perform
any additional custom analysis or graphing.

E spart
’7|F'i:-:els jITe:-:t j Export |

Units —You can select what set of units to use for exporting the tracking results. If no
calibration has been done on the video, then this selection is ignored and the values
are output in Pixels.

Format —You can select what format to export to: Text, Excel Blank, or Excel Template,
or Diadem. Results for each of the lines and for the circle fit will be exported to the
resulting file.

In all formats, the line settings and the line track data will be output for each line and the
circle fit settings and circle fit data will be output.

e The line track data is composed of the following information: frame number, time
(if we know the record rate of the video), the X and Y coordinates of the tracked
point, the distance from the tracked point to P1 along the line, whether the
transition was white-to-black or black-to-white, and the intensity level of the image
at the tracked point. If multiple targets were allowed for each line, then for every
frame, there will be multiple rows in the output, one for each target. Values of 1
indicate that a tracked point was not found for that frame.

e The circle fit data is composed of the following information: frame number, time,
the X and Y coordinates of the center, and the radius. If a fixed center was
selected, then the X and Y coordinates of the center will always be the same.

o  When exporting to a text file, information for each line and for the circle fit is
appended to the single output text file. WordPad will be launched on the text file
that was just exported.

e For Excel Blank, a new workbook will be created that contains multiple sheets.
The first set of sheets will correspond to each of the lines that have been added.
The last sheet will contain the circle-fitting results. Excel Template produces the
same results; however, the data is imported into an existing Excel file that is used
as a template. You can put in any formulas and graphs into the template file, and
these will be recomputed and regenerated when the new data is exported into it.

e For Diadem, the results are exported to a DAT file that can be loaded by Diadem.

Export — When you are satisfied with your tracking results, and have selected your
export units and format, click on the Export button to export the results.
Graphing

Line tracking results can be immediately displayed in the Measurements Window graph
section. Refer to the graphing subsection of chapter 3.



Saving and Loading Projects,
Videos and Files

Saving Video Files

Video files analyzed with ProAnalyst may be from one-time events or require complex
conditions to setup. Therefore, ProAnalyst always avoids modifying pixels in an original
image, such that they are always identical to what was acquired. Analysis results, image
processing and filtering, and other operations are stored separate data files so that they
do not require overwriting or rewriting the video image.

There are occasions where the video itself will need to be saved to another file, for
instance:

e Saving a subset of frames to a new file.
e Splitting a long recording into smaller pieces.

e Changing the save format from AVI to bitmap files or any other format
conversion.

e Saving processed results to another file for easier processing.
e Saving processed videos with all overlays (tracking, annotations, etc.).
e Saving a sub-region of the video images.

In all these operations, the original file is kept intact and a new file is created with the
modified images and information.
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Save Dialog

The Save Video dialog is similar to the standard Windows save dialog, with additional
options beneath the standard controls. The Save Video dialog can be brought up in
several ways. Click on the Save button H on the main toolbar when the active window is
a Measurement Window, use the File > Save As menu option, or use the keyboard

shortcut Ctrl+S.

Select the directory to save in and enter the filename to save as in the upper sections of
the dialog. The lower sections of the dialog provide advanced save options that are

explained below.

21|
Savejn:l@ Clipz j - I‘j{ v

File name:  [spindisk. avi Save |
Save az lype: IAVI File: [, i) ;I Cancel |

Save Range

@ 5 ave enlire range " Save frames I-?H to I-EII

[~ Skip every |1] frames Estimated Size  |40.75 MB
[~ Span multiple files j |212 frames
Save Options

[ Save enciypled I~ Ericropt data and notes

I” | Save associasted data [~ Save annotations and notes

[T Save frames with image processing and LUT (not reversible)

Saving Subset of Frames

To shorten a video or to focus on one section of the video, you can save a subset of

frames or skip frames.

Save Range

 Save enlire 1ange ¢ Save frames |-4DD ta I-SDH

v Skip every [1 frames Estimated Size |9.51 kB

[ Span multiple files J IED frames

1. Save entire range — This option will save the entire set of frames from the original

video. This is the default behavior.
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2. Save frames — A range of frames between a start and end frame can be specified.
The start and end frame must be valid frames in the video.

3. Skip every [x] frames — A reduced set of frames can be saved by skipping some
frames. A skip value of 1 would save every other frame. A skip value of 2 would save
one frame, skip 2, save the next frame, and so on. The default is to save all frames
(skip value of 0). Skipping frames is not recommended in general unless you know
what you are doing since this will alter the apparent frame rate of the video.

4. Estimated Size — Displays the estimated size of the total resulting video file(s).

5. Span multiple files — This option can be used to split the video into separate video
pieces that can be loaded seamlessly as if they were one video.

Spanning Multiple Files

The standard Microsoft AVI file format supports up to a maximum of 2GB per file (with
some extensions that can go to 4GB). Occasionally you may need to save a video in
smaller pieces to save to a CD-ROM or other device. You can save sub-ranges using the
Save Range portion of the Save dialog, or you can use the spanning functionality of this
software.

This software will automatically span a video file into smaller pieces of a specified size.
The resulting files will be reloaded as if they were one single video file. These partial
pieces will be given the PVI file extension.

To SAVE a video to a spanned set of files:

File name: spindisk. pui Save i
! |—I 1. Check the Span multiple
Save as lype: | Partial Video File [* pvi] =l Cancel | files checkbox in the
Save dialog.
Save Range 2. Drag the slider until the
' Save entire range " Save frames |-511 to |'3UU desired Estimated Size
™ Skipevery [0 frames Estimated Size  |9.61 MB for each part|al V.Ideo file
) _ appears in the dialog.
v Span multiple files J IED frames

3. Ortype in the desired size for each partial video file in the Estimated Size edit
box and click Tab to update the slider and number of frames.

4. Or type in the desired number of frames for each partial video file in the frames
edit box and click Tab to update the slider and Estimated Size.

5. Click the Save button to execute the save operation.

To LOAD a spanned PVI file, click on any of the PVI portions in the Load dialog and all
portions will be automatically identified and loaded.
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Saving Processed Video

To speed up playback of processed video, a video can be saved with the processed
settings applied to it. The original file should be left on the hard drive. The save processed
operation is not reversible.

Save Dptions

[~ Save enciypted ™| Encrupt data and notes
[T Save associated data [ Save annotations and notes

[ Save frames with image processing and LUT [hot reversible]

1. Save encrypted — A user supplied pass-phrase can be used to encrypt the video
frames of the new video. Anyone wishing to video the encrypted video will be
required to type in the identical pass-phrase. Use this option carefully, if the pass-
phrase is forgotten, the original video images cannot be retrieved.

2. Encrypt data and notes — Along with the video frames, the associated data and
notes, if present, can also be encrypted with the same pass phrase.

3. Save associated data — If acquired data is present in the current video, this data can
be saved with the new video or it can be ignored. Check this box to save a copy of
the current data with the new video.

4. Save annotations and notes — The annotations and notes associated with the
current video can also be saved to the new video. Check this box to save a copy of
the current annotations and data with the new video.

5. Save frames with image processing and LUT — The Image Processing and Image
LUT settings can be applied to the video and the results saved in the new video file.
Normally the Image Processing settings and the Image LUT settings are stored in
separate files. These settings are loaded and applied to the video image every time
the video image is drawn. The original video file is not modified and the Image
Processing and Image LUT settings can be turned off at any time. When saving with
processing, the newly created file will have the current Image Processing and Image
LUT settings permanently applied. This saves computation time when the new
processed video is loaded, however the changes cannot be turned off for the new
video. Note that this process is not reversible. You cannot obtain the original file back
from the resulting processed file.

6. Include Overlays — This option is only available if "Save frames with image
processing and LUT" is selected. This option will save any overlays that are drawn on
top of the video image as displayed on the screen. This includes any analysis track
points, annotations, captions, etc.. Note that this process is not reversible. You
cannot obtain the original file back from the resulting processed file.

Saving Sub-Regions of Video

Using the zoom window, a sub-region of the video image can be saved to a separate
video file. This can reduce the size of the resulting video and remove background
sections that are unnecessary.
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Importing Data

Data from external sources can also be imported and aligned to video sequences. The
external data must be contained in a text file where each line contains one set of data.
The text file may also contain comment lines, these comment lines should be indicated

by

having a special character at the start of each comment line. Blank lines are ignored. All

other non-comment lines should contain the same number of values. These values can

be separated by spaces, tabs, commas, or any other delimiter. Below is shown an

example of a suitable text file. In this file, comments are indicated by the '#' character and

each uncommented line contains five (5) values separated by tabs.

E demo_heartvalve.bxt - WordPad

=101

Eile Edit Wiew Insert Farmat Help

Dlz|d| S| sl & 2|@] |

# Scan Rate: 20000 i’
# Scans FPer Frame: 20

# Total Scans: 6020

# ZP: 0 TF: 0O

# Nuwber of Channels: 3

# Scaled: o

# Scale Factor: 1.000000e4002 1.000000e4002 1.000000e+4+000
# Offset: 0.000000e4000 0.000000e+000 0.000000e+4+000
# Label: A E
# Units: b Tom
# Index Time Ch.oo Ch.0O1 Ch.03
a 0. 0000000 9.76ee001e-003 1.049500e-001 1.196000e-001
1 0.00aos500 4.150400e-002 1.416020e-001 1.221000e-001
Z 0.0001000 4., 150400e-002 1.41602Z0e-001 1.196000e-001
3 0.0001500 3.906300e-002 1.41602Z0e-001 1.074000e-001
4 0.000&000 3.906300e-002 1.416020e-001 1.555000e-001
=] 0.000z500 3.908300e-002 1.416020e-001 3.271000e-001
] 0.0003000 3.908300e-002 1.440430e-001 3.345000e-001

For Help, press F1

N K

Importing from Text

To import data, select File © Import Data

Enter the name of the text file to load the data from by typing in the name in the Filename

box or by clicking on Browse to select a file. If you would like to review the contents of
the file you have selected, click on the Edit File button, and the file will be opened with
WordPad.
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Import Data il

— D'ata File
Filename || Browse | Edit Fil |

— Comment Indicator

The data file may contain comment lines at any location in the file.
Each comment line must begin with a comment indicator.

&+ Pound [#] " Peicent[%] Slashes [//] " Other I

— Field Delimiter

All lines that are not comments are azsumed ko contain data.
Each data line must contain the zame number of fields separated by a delimiter.

&+ ‘Whitespace [] ¢ Commal,] " Semicolon ;] ¢ Other I

— Data Infarmation

Indicate whether any initial columng contain special information not to be graphed.
[ First field contains : £ Sample Mumber € Times
[ Second field contains : £ Sample Mumber € Time?

*Time values will be used to verify the zero-th zample, but are not uged for alignment.

The data may have been zampled at a faster rate than the video.
To align video and data, indicate the zamples per frame and the zero-th zample.

Samples per Frame I'I Zero-th Sample I‘l

Import I Cancel |

In order to properly interpret the contents of the text file, information about the
formatting of the file must be provided.

Specify the Comment Indicator used in the text file. Typical characters are listed
for convenience. You may use one of these or you may enter your own
character(s) by selecting Other and typing in the correct value.

Specify the Field Delimiter used in the text file. This is the character(s) that are
used to separate data values on each line. Typical values are listed for
convenience. You may use one of these or you may enter your own character(s)
by selecting Other and typing in the correct value.

Often data files contain special data in the first few columns that should be
treated differently than the other columns. If the first and/or second column
contains information that should not be graphed, then check the appropriate box
and indicate what is contained in that column. Note that these values are not
used to perform alignment. The Time value will be used to verify the zero point,
but otherwise, these values are discarded.

In order to properly align the data to the video, information about the sampling
rate and zero position of the data must be provided. The data must have been
sampled at an integer multiple of the video rate in order to align properly. Enter
in the number of data samples that correspond to one video frame in the
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Samples per Frame box. For instance, if the data was sampled at 1000 Hz and
the video was recorded at 100 fps, then enter a value of 10 for samples per

frame.

6. Next, specify the number of the data line that should be used as the zero-th
sample. This data sample will be aligned with the zero frame of the video. For
instance, if the 100th data line in the text file represents the zero point, enter 100
in the Zero-th Sample box. If the first or second field was specified to be a Time
value and the data line where the Time value is zero differs from the value you
have entered for the zero-th sample, you will be asked which value to use in

alignment.

7. If the data does not align as you had expected, try importing the file again with
different samples per frame and zero-th sample values until you achieve the
desired alignment.

Exporting Data or Analyses

Data and analysis results can be exported to multiple file formats: Text, Excel (with or
without a template), or Diadem. This selection of export formats was chosen to try to
support the widest variety of customer's needs. Using one of these formats, it should be
possible to directly, or with a small amount of modification, load the data or analysis
results into most popular graphing or data analysis software packages.

File Edit Wew Tools Window Help
Chrl+M

Mew Project
Open Project...
Qpen Yideo\Daka, ..

Chrl+0

MNew Video Explorer
Mew Yideo Timeline

Open Workspace. ..
Save Workspace. ..
Close Workspace

Save

Save As...

Save Recorded|Parameters
Save Modified Bata

Save Annotations

Sawve Zoom Region, ..

Close

Chrl45

Irnport Data
Expork Data

Print
Print Setup...

1 demo_hobwheels, avi

Exit

To export data, use the File > Export Data menu.

To export analysis results, use the Export section of
each analysis control panel, if present. Only analysis
modules that support exporting will have this section
present on the lower portion of their control panel.

— Expaort

Pivels jITe:-:t j Expaort |

To Excel
To Diadem
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Exporting to Text

Text files are suitable for loading into any program that can load data in a comma
delimited format (e.g. Matlab or Excel). Some small formatting may be required to have
the text files load properly depending upon the application you are using to load. Lines in
the text file that do not contain the explicit data are prefaced with a # to indicate that the
line is a comment or information line rather than a data line.

When exporting to Text, WordPad is opened with the newly created file.

Bl demo_heartvalve.txt - WordPad

File Edit Wiew Insert Farmat Help

=101x]

D= Sl sal 5 (=@ B

Far Help, press F1

# Scan Rate: 20000 3
# Scans Per Frame: 20

# Total Scans: 6020

# ZP: O TF: O

# Nunber of Channels: 3

# Scaled: o

# Scale Factor: 1.000000e4002 1.000000e4002 1.000000e+4+000
# Offset: 0.000000e4000 0.000000e4000 0.000000e4000
# Label: A B

# Units: Teen oo

# Index Time Ch.OoO Ch.0O1 Ch.03

u] 0. 0000000 9.766001e-003 1.0498300e-001 1.196000e-001
1 0.0000500 4,150400e-002 1.41602Z0e-001 1.2z21000e-001
2 0.0001000 4,150400e-002 1.416020e-001 1.196000e-001
3 0.0001500 3.908300e-002 1.416020e-001 1.074000e-001
4 0.000z000 3.908300e-002 1.416020e-001 1.5355000e-001
=] 0.000z500 3.908300e-002 1.416020e-001 3.271000e-001
5 0.0003000 3.906300e-002 1.440430=-001 3.345000e-001

N K

Exporting to Excel

Exporting to Excel requires the workstation to have a version of Excel currently installed.
An instance of Excel is launched and the data is directly written into the Excel
spreadsheet. In order to save the results, you must save the resulting spreadsheet from
inside of Excel. To export to a blank Excel sheet, use the Excel Blank format option.
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JF\Ie Edit Wiew Insert Format Tools Data Window Help

©-o- R A Anllﬂamn% 3. - %P2
| aria S I=E==H|%%, 49)= -
O] [
A B C D E F G H | [

1 |

| 2 |[Name: |D:\Clipsidema_heartvalve. au?

3

TPruper(ies

| 6 |Scan Rate 20000

| B |Scans Pel 20

| 7 |Total Sca 6020

| 8 |Number o 3

| 8 |Scaled: Mo

| 10 |Scale Factor: 100 100 1

| 11 | Offset: 0 0 0

| 12 |Label: A E

| 13 |Units: mm mrm

| 14]

15 [Index Time Ch. 0 Ch. 1 Ch. 3

| 16 | 0 0 0009786 0.10423  0.1186

| 17 | 1 000005 0041504 0141602 01221

| 18 | 2 00001 0041504 0141602 01186

| 19| 3 0.00015) 0032063 0141602 01074

| 20 | 4 00002 0032063 0141602 01855

| 21| 5 0.00025) 0032063 0141602  0.3271

o) 0.0003 0032063 0144043 0.3345

[ \Sheetl { Sheetz £ Sheets / Kl 4
Ready | I T ) I

You may export to Excel with a template file. When using a template file, Excel creates a
new document that contains everything that is in the template file. The portion of the
Excel sheet(s) that normally contain the exported data is overwritten. All graphs and
formulas that are based on the exported data will automatically be redrawn and computed
using the newly exported values. This is an easy way to reproduce any graphs or
calculations made in Excel when doing similar tests. To export to Excel using a template,
select Excel Template from the export format options.

Exporting to Diadem

Exporting to Diadem does not require the presence of Diadem on the workstation. Two
data files are generated when exporting to Diadem, one has the R64 file extension and
the other has the DAT extension. When exporting to the Diadem format, you will be asked
to specify the DAT file and the R64 file will be named with the same base filename, but
with the R64 extension. Both files are required for loading into Diadem.

Save in: Iﬁ Clips j & = ER-

2=

File name: Save

[ see |
Cancel |

Save az lupe: IDiadem Data Files [*.dat)

=

o

An instance of Diadem is not
launched when exporting.
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File Management

Saving
One of the most important aspects of this software is the ability to save and load all the
components of your work. The following information may be saved (and later reloaded):

e Video

e Data

e  Motion Analysis

e Image Processing

e User Notes and Annotations
e  Calibration Information

e GPS/IRIG Timing Data

This software uses a video-centric file naming convention. That is, you name the video file
during the save procedure and all the other files are saved with the same filename, but
different suffix. During the Save As... process, you are asked for one filename. All the
various pieces of your test are named this filename with a different 3-letter suffix (e.g.
filename.avi, filename.cfg, filename.ant, etc.).

Image processing settings, calibration information, analyses, and most other saved files
can be saved and reloaded independently through their respective control panels. For
more information on saving and reloading saved settings, consult the corresponding
sections of this user guide.

Moving Files

When copying or moving files, it is very important to move all files of the same name.
Critical information or user-added content may not appear if all files are not moved
together.

& D:\.Clips'flame =10l =]
File Edit ‘iew Favorites Tools Help ﬁ
EBack « = - | B search [YFolders £ | 5 05 % e | E-

Address Ia Flame j o

| Sizel Tvpe I
1KB ANT File
] Z,270KE  AVIFile
combustion.cfg 1KB CFGFile
combustion. clb 1KE CLEFile
combustion. Itk KB LTK File
combustion. mpj 1KE MPIFile
4| | JLi|

6 object{s) selected 2,22 MB A My Computer
4
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Yideo Explorer 1 - lip:

B[ lo e 1= aln o

Also, be aware of projects that many contain references to a video you are moving. If you
move the videos without moving or changing the contents of a project, the project will no
longer be able to locate the video.

Browsing Through Files

A quick and easy way to browse through video files is to use the Video Explorer Window.

FoAClipsh

[F: 0] ||demo_heartvalve.avi [F: 0] ||demo_hotwheels.avi

Play Forward
Play Rewerse
Stop Playback

Jump To Start

Jump To End
[F: 0] ||demofiles.mpj [PROJECT]

Conkinuous Loop

R W] [

This window allows you to see and interact with thumbnail versions of the video and data
for each recording in a directory or in sub-directories.

File Extensions

Many different files are created to store various portions of your measurement and
analysis. A complete listing of possible file extensions and their contents is provided here.

e AVI, BMP, TIF, JPG - Standard save formats for video files. Either saved as a
single video file (AVI) or as a sequence of images (BMP, TIF, JPG).

e  PVI - Partial Video file. This file is an AVl file that is a portion of a larger video
consisting of sequentially named PVI files. These files load seamlessly as one
large video file.

e ANT - Annotations file. Contains all annotations associated with the video. This
file is loaded automatically if present when the video is loaded.

e AU2 - Data file for acquisitions done with MiDAS software. This file is loaded
automatically if present when the video is loaded.




62

ProAnalyst Getting Started Guide

AU3 - Binary data file for MiDAS software. Contains user notes, GPS/IRIG time
information, and other per frame information. This file is loaded automatically if
present when the video is loaded.

CFG - Configuration file for MiDAS software. Contains record rate, shutter
speed, zero frame and other record settings for a video. This file is loaded
automatically if present when the video is loaded.

CLB - Calibration file. Contains the calibrations settings saved via the
Calibration panel.

CLR - Bayer Color Coefficients file. Contains color coefficients for decoding
Bayer formatted video files. This file is loaded automatically if present when the
video is loaded.

FTK — Feature (2-D) Track file. Contains the settings and analysis results for the
Feature Track panel.

GFC - Graph Configuration file. Contains a listing of all data display and filtering
settings from the Configure Graph panel.

GFL — Graph Filter List file. Contains a list of filters saved from the Filtering sub-
panel of the Configure Graph panel.

IMP — Image Processing file. Contains the list and settings of the chain of image
processing filters to apply to a video from the Image Processing panel.

LTK - Line (1-D) Track file. Contains the settings and analysis results for the
Line Track panel.

LUT — Image LUT file. Contains the brightness, contrast, gamma, and other LUT
settings from the Image LUT panel.

MPJ —Project file. Contains a listing of all video and associated files contained in
the project.

MWK — Workspace file. Contains a list and layout of various windows in a
workspace.

R64, DAT — Diadem Data files. These files are generated when exporting to
Diadem using any of the analysis modules or the data export features.

STB - Stabilization file. Contains the settings used to stabilize a video using the
Stabilization panel.

TXT — Text file. This file is a plain text file and is generated when exporting to
Text using any of the analysis modules or the data export features.

XLS — Excel Spreadsheet file. This file is generated when exporting to Excel
using any of the analysis modules or the data export features.
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Report Contents

% Professional Analyst

Page 1

=10l x|

ﬂexlF’ageI F'rEgF'agel Iqu’agel Zoom In I ZUDmQuII Close |

Video : D:\ProAnalystiExample Files\demofilestdemo_hotwheels. avi
Record Rate : 500 fps

Number of Frames: 73

Data Rate : 12500 Hz

Samples Per Frame : 25

Total Samples : 1525

Global Note :

** Hot Wheels Car Crash Demanstration File =
Test Summary

A model car was instrumented with an accelerometer attached to windshield
A gecond accelerometer was placed on the backside of a Lego wall.

The car, which had a spring star, was smashed into the wall

This file dernonstrates the benefits of synchronizing high-speed

video with sensor data, and of MIDAS's auto-tracking capabilities

for any feature type

MIDAS Features Used

Module DA-1230 Synchronized Data Acquisition
Module SAZ Spreadsheet Analysis with auto-tracking

(&) 2001 Xeitex, Inc

Professional Analyst 1.1.7.6 7 Xelitex, Inc

September 23, 2004 — 03:48:46 P

| 220 (h) x 279 (v} pizels

B:z

Automatically
generated reports
obtain their content
from the video, data,
analysis, notes, and
annotations. These
are assembled and
output in a structured
format suitable for
printing or web
distribution. The Print
and HTML formats
have essentially the
same options and are
built from the same
content material.

Reports are
composed of a cover
page, which displays
video and data
information, an image
of the first video
frame, a data graph
of the acquired data if
present, and the
global note
associated with a
video.

All subsequent pages
are composed of
blocks of video
images and
comments or data
plots and comments.
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%: Professional Analyst i =] |

Print... = PraxF'agal lwoF'agel Zoam In | Zaamgutl Cloze I

Blocks are added to
the report and
formatted according
to the guidelines

specified in the
Step 1t Select View, then Tab Manager. Select Lnalysis Tab SA2 .
Step 2 Select the general purpose Excel template: Re port Optlons .
-- Onthe SAZ2 tab, click on Select button.
-- Select the SATemplate. xls Excel template:
Step 3 Click on the Mew button
Setthe "Mumber of Features to Track 1o 2
Step 4 Select Show "All Frames"
Step 5 Calibrate the image
-- Click on the Calibrate button.
-- Move the crosshairs 1o the front of the car
-- Balect Set Point 1
-- Move the crosshairs 1o the base of the wall
-- Select Set Point #2
-- Inthe Scale Factar fisld, type 8.00 inches. Click OK
: Options:
-- Click on the Cptions button
-- Un-select "Drawe & line between festures"
-- Select "Auto-Advance to next feature”
-- Select "Auto-Advance to next frame”
-- Select "Twin step process: left click select and right click”

Video : D:\Frofnal ystiExample Files'de mofiles\demo_hotwheel s avi Page 2

Frame 0 Time : 00:00.0000000

Frame 0 instructions:

Click OK
Daturm O [Frame 0/ Datum 0] : Time : 00:00.0000000

Data Index 0 instructions:

Step 1: Select the Play tab
Step 2 Data was recorded st 12,500 samples/second-channel or
25 points per video frame per channel.
Step 3 Expand the graph
-- Cick on Tools, then Create Mew Graph
-- Separate the two graphs on the screen.
-- Onthe nevw Graph, click on the Zoom button
-- Draw @ box around the impact region of the data
Step 4 Using the slider bat on the video window, move
throughout the image and view the relationship
hetween video and data.
Step 5 Goto Data Index 625 (Frame 25)

Frame 1 Time : 00:00.0020000

Frame 1 instructions:

Step 1: Click on Enable
Step 2 Creste the tracking template
-- Click on Create
-- Draw & box around the bowx surrounding the number
'3 onthe car door. The zoom box automatically
appears to help adjust the location.
-- Click on Accept

Professional Analyst 1.1, 7.6/ Xeitex, Ine. September 23, 2004 — 03:45:46 PM

Page 2 || 320¢h) =279 (vipiels [ 2 2

Adding Content

Any frame that contains a comment or annotation will automatically be included in the
generated report unless specified otherwise in the Report Options dialog. In addition,
the Report Options can be changed to include other frames that do not have comments or
annotations.

The content that is displayed in the report comes from many sources:

e To add video or data comments, use the Notes control panel. Comments can be
added for each video frame, each data point, or for the entire video.
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e To add annotations, use the Annotations control panel or toolbars to draw
annotations over the video images. Annotations can be set to appear in a single
frame or in all frames. Annotations that appear in a single frame will cause that
frame to be included in the report generation. Annotations that appear in all
frames will not force every frame to be included in the report.

e Changes to the image appearance using the Image LUT or Image
Processing will be visible in the report if the "Processed" tab is selected in the
Measurement Window when the report is generated. If the "Raw" tab is
selected in the Measurement Window, then the raw video images will be used in
the report.

e Allvisible analysis results that are shown in the Measurement Window will
also be shown in the report (unless disabled in the Report Options).

Using the Report

The results from the Report Generator can be used to supply content to a wide variety of
productivity applications. HTML versions of the report can be imported into other typical
word processing applications such as Microsoft Word. HTML versions can also be saved
as plain text files using standard web browsing applications. These text files combined
with the set of image files automatically generated with the report can be incorporated into
a wide variety of word processing or presentation applications.HTML reports are output to
a single HTML file that is specified in the |. The video images and the data plots are
created as bitmap files that are stored in an images directory. The image directory is
located in the same directory as the HTML file. The directory is named after the video
filename with a "_imgs" appended to it. For example, for the demo_hotwheels.avi video,
the HTML file was named demo_hotwheels.html and the image directory was named
demo_hotwheels_imgs.

Report: D:\Clips\demo_hotwheels.avi

Video : demo_hotwheels.avi
Record Rate : 500 fps
Number of Frames: 73
Data Rate : 12500 Hz
Samples Per Frame : 25
Total Samples : 1825

0 Pl e s A b
ot seifrr el

’M A erecgoro . et Ml bt o
e el L T

1
—

Global Note :
**% Hot Wheels Car Crash Demonstration File ***

Test Summary
4 model car was instrumented with an accelerometer attached to windshield
A A arcelernmeter was nlaced on the hackside nf a Tean wall

] [T g o

h Il
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Report Options

Options Dialog

When the report generator is started, an initial options dialog window is displayed. The
various configurable options for the report generator are described in this section.

Destination
Select the type of output for the report:

e Printer will send directly to a printer,

e  Print Preview will display a preview window, and

e HTML generates an HTML page and associated images.

Generate Report x|

Destination | Setup I Widea I Data I

Tope
Browse |

Filename ID:\Clips\demo_hotwheels.html

Generate I

Cancel

Setup

Depending upon the type that is
selected on this tab, the contents of the
Setup, Video, and Data tabs will change
appropriately.

The setup options allow you to configure the overall format of the report.

Generate Report x|

Destination  Setup |Video I Data I

¥ Piint cover page [contains global note)

¥ Frint page header

W Print page footer

Include
¥ Frames with notes ' Only data with notes
[~ Every |1— jl framefs] ¢ Al comesponding data

Generate I

Cancel |

o Print cover page — The cover page
provides a summary of the video and
data. It includes an image of the first
video frame, a graph of the complete
data, and the contents of the global
note if present. Select this checkbox
to include the cover page.

o Print page header — The page
header includes the name of the file
and the page number. Select this
checkbox to include a header on
every page.

e Print page footer — The page footer includes the application name and the date
and time. Select this checkbox to include a footer on every page.
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After the cover page, the remaining document is composed of blocks of frames with
notes or data with notes. In the default setting, only frames or data that contain notes or
annotations will be included in the generated report. Additional frames that do not contain
notes can also be included in the report by modifying the Include options.

¢ Frames with notes — Check this box to include every frame that contains a note
or annotation.

o Every [x] frame(s) — Check this box and specify an interval to automatically
include equally spaced frames throughout the entire video.

e Only data with notes — Select this option to only include data graphs if the data
has an associated data comment.

e All corresponding data — Select this option to include the associated data
graph that corresponds with a video frame that is displayed regardless of
whether the data itself has an associated data comment.

Future versions will have greater flexibility in what is included in the generated report.

Video

The video options control how the video frames are displayed in the generated report.

x|
Destination | Setup  Yideo I [rata I

I¥ Display frame images

Dizplayed image zize
30 % |20

Sizez are shown az a
percentage of the full
PAGE size

I

¥ Show Annotations
v Show Track Paints

Generate I Cancel

o Display frame images — Check this box to include frame images. If this box is
not checked, video images will not be included in the generated report.

 Displayed image size — Specify the maximum image size on the page. For the
Print and Print Preview destinations the size is given as a percentage of the total
page size. The image will be resized to fill the specified size while maintaining
the same aspect ratio. The image width cannot exceed 50 percent of the page
size in order to leave room for user comments. For the HTML destination, the
size is given as dimensions in pixels.
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e Show Annotations — Check this box to include annotations in the frame images
that are displayed. The annotations must be visible in order to be displayed.

e Show Track Points — Check this box to include analysis track results in the
frame images that are displayed. Analysis must have been completed and
visible in order to be displayed.

Frame images are displayed in the raw or processed form depending upon which tab is
currently selected in the Measurement Window when the report is generated. If the Raw
tab is selected, the raw frames will be incorporated. If the Processed tab is selected, the
processed frames will be incorporated.

Data

The data options control how the data graphs are displayed in the generated report.

Generate Report |

Destinatianl Setup I Yiden Data I

v Display data plats

Data plat size Sizes are shown as a

|3|:| % |2|:| = percentage of the full
PAGE zize

" One data plot per video frame Frames of context data

¢ Multiple data plots per video frame |5 ill

Generate I Cancel

o Display data plots — Check this box to include data plots. If this box is not
checked, data plots will not be included in the generated report.

o Data plot size — Specify the data plot size. For the Print and Print Preview
destinations the size is given as a percentage of the total page size. The image
width cannot exceed 50 percent of the page size in order to leave room for user
comments. For the HTML destination, the size is given as dimensions in pixels.

e One data plot per video frame — A single video frame may contain multiple
data points that have associated user comments. A single data plot can be
generated for this video frame or multiple data plots can be generated for each
data point that has an associated user comment. Select this option to generate a
single data plot per video frame.

e Multiple data plots per video frame — A single video frame may contain
multiple data points that have associated user comments. A single data plot can
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be generated for this video frame or multiple data plots can be generated for
each data point that has an associated user comment. Select this option to
generate separate data plots for each data point that has an associated
comment.

e Frames of context data — For every data point that is plotted, a range of data
points before and after the point of interest is included in the data plot. The
amount of data shown before and after the data point of interest can be specified
here. The amount is given as the number of frames worth of data to be displayed
in each graph. For instance, if the data is sampled at 10 samples per frame, 5
frames of context data would generate plots that have 50 data points each.

Only data that was acquired with the video is included in the data plots. Graphing of
analysis results is not included in the generated report. Future versions will incorporate
analysis graphing in the report generation
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Tutorial 1: Learning to Use ProAnalyst

If you are new to ProAnalyst, this tutorial, which can be completed in 15 minutes or less,

will provide you with a strong foundation from which to further explore the capabilities of this

powerful video analysis package.

This lesson will provide inexperienced or first time users with a step-by-step walkthrough of

ProAnalyst’s general usage. Included is an explanation of the most important aspects of

the ProAnalyst interface, as well as a step-by-step guide to creating and managing project,

importing data, calibrating and processing an image, motion tracking, user-defined content,

and report generation.

Files Needed for This Tutorial

1

2
3.
4

demo_hotwheels.avi
demo_hotwheels_data.txt
demo_heartvalve.avi

demo_switchblade.avi

Step 1 — Creating a New Project

Begin by launching ProAnalyst. You may either double-click the mouse on the ProAnalyst

desktop shortcut, or select ProAnalyst from the Windows Start menu.

Select File > New Project from the main menu to create a —
« Untitled Project 1 [= |[B][%]
new project file. An empty Project Window [ Figure 1 ] will
appear in the upper left-hand corner of the screen. ERh
Add videos by using
Projects are used to manage video and data files as well as 2 O (I BT T

their associated calibration, analysis, and processing

configuration files. Project uses can vary from keeping track of Figure 1

multiple views of the same object, to running comparisons

between different videos or analyses. Projects are strictly
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bookkeeping files — they do not actually move or alter any files

“ Untitled Project 1 [= [8)[X]

2EH|§= cm B @

on the computer or network.

New videos can be added through a pop-up menu, accessible
by right-clicking the mouse inside the Project Window. Select
Project > Add Video(s)... from the pop-up menu [ Figure 2],
and load the demo_hotwheels.avi video file.

Fit Window to Cortents
v Align Yertical
Align Horizontal

Figure 2

The Project Window can contain and manage multiple video files. As an example, repeat
the previous step to add the demo_heartvalve.avi and demo_switchblade.avi videos.

Step 2 — Navigating the ProAnalyst Interface

The ProAnalyst interface consists of 4 primary windows. Currently the Project Window,
Workspace View, and Active Timeline are visible. The Measurement Window can be
launched by double-clicking the mouse on the demo_hotwheels.avi video thumbnail. Your

workspace should resemble Figure 3.

EEIE
Fie £3 Yew Tods Widow Hep
DA SH BEEAABES RSARB T o8 FE
B orkspace View
T s
= By UnetedProgect 1

nE AP iy dora_bokwbosls
» B como_beartvshe
- R oo wmterdhco
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o P Explrers g Tersies
=
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w
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“u,
®
Ed
o]

Crsr sew +

| IEIRIES IR0 Ry =
] 0 uw aAm R [pomooy Pt i
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" 5 Tvee [0 o] =
B 520 (279 (o poees ) 520 (8 200 (o7 670 1 4550 e

Figure 3
A. The Project Window manages multiple video and data files, and provides thumbnail

views of project video clips.
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B. The Measurement Window is used for video processing/analysis and graphing

actions. The majority of ProAnalyst work takes place in this window.

C. The Workspace View displays active projects, as well as their associated video, data,

and configuration files in either tree or graphical format.

D. The Active Timeline provides synchronization and visualization of multiple video
tracks, data, and graphs. Data patterns and subtle events can be easily viewed from

this window.

This tutorial will focus primarily on the Measurement Window. The Workspace View and
Active Timeline will not be used. These windows may be closed by clicking the ‘X’ button

in the top right or left hand corner.

The Measurement Window in Depth

The majority of video and data analysis takes place in the Measurement Window. Across
the top of the Measurement Window is the Main Toolbar [ Figure 4 ], which controls the
viewing options and appearance of the video controls, video image, and displayed data.

= wME HEHME M 1ME 4 s

Figure 4

The Video View tabs [ Figure 5], located along the left side of the Measurement Window,
provide different viewing options for the video image.

% Raw displays the original, unaltered video image directly from the source file.
(it
T
% Processed shows the results of any Image Processing or Image Filtering
a operations on the video image.
&
E
5
E Thumbnail displays a thumbnail summary of the entire video sequence.
=
Figure 5

Along the right side of the Measurement Window is a toolbar that contains a column of
icons [ Figure 6 ]. Each icon in the toolbar opens a control panel representing an operation
that can be performed on a video. Note that the specific icons that appear will depend on

which version of ProAnalyst you are using.
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i B

= B Mm@

L l..+. 1::" LJ:I;! E

L A

Figure 6

Image Processing controls color balance, brightness, contrast, etc.
Image Filtering contains powerful image manipulation tools.

Image Calibration allows calibration to real-world coordinates.

Display Layers controls what is displayed in the video image.

Notes allows recording/editing of notes relating to the current video analysis.
Annotations allow the user to add graphical annotations to the video image.
Line (1D) Tracking follows intensity changes along a one-dimensional line.

Feature (2D) Tracking tracks distinct features across all video frames.

Stabilization removes unwanted bounce or jitter prior to video analysis

Contour Tracking tracks the contour of an object frame-by-frame.

Particle Tracking automatically detects and characterizes particle motion.

Cellular Tracking tracks the flow of biological cells through veins and arteries.

Configure Graph customizes graph output, including analysis and data.

Save All Modules will save any or all modules and toolkits that have been modified

A set of video play controls [ Figure 7 ] are located at the bottom of the Measurement
Window.

IEI..‘ » B A »|prl C g Slow Fast
0.00 24,00 29.00 Z200  |0.000000 Playback Ratio 1:1 = frames
D. . |24| . |48| . |?2 0 #vg, Plapback Rate | 205 fps
e ———
lr oo =[] 0 Jump Zoom
Figure 7

The Play Controls allow for forward or reverse video playback or frame-by-frame stepping.
The video length, current frame, and current time are displayed, as well as frame jump,
frame skip, and continuous playback options. Refer to the ProAnalyst User Guide for more

details.
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Step 3 — Importing and Synchronizing External Data with Video

Known as “sensor fusion”, the synchronization of video and sensor data provides a much
richer understanding of events than either technology alone. ProAnalyst allows users to
import data streams from external sensors and gauges, and then synchronize the data
streams with video(s). If video and data were recorded together in one of ProAnalyst’s

supported formats, the data would be automatically read and synchronized.

To import external data contained in an ASCI| text file, open the Import Data dialog box [
Figure 8 ] by selecting File > Import Data = From Text. Click the Browse button at the

top of the dialog, and select the demo_hotwheels_data.txt file.

Import Data

Drata File

Filename || Browse E dit File

Comment [ndicatar
The data file may cantain comment lines at any location in the file.
E ach comment line must begin with a comment indicator.

" Pound [#] " Percent (%] O Slashes [#/) " Other

Field Delrniter
Alllines that are not comments are assumed to contain data.
Each data line must contain the same number of fields separated by a delimiter.

o whitespace (] Comma[,) " Semicolon(;] ¢ Other

D ata Information
Indicate whether any initial columng contain special information nat ta be graphed

I First field contains : r o
I Second field contains : r o
“Time values will be used to verify the zerath sample, but are nat used for alignment.

The data may have been sampled at a faster rate than the video.
To align video and data, indicate the samples per frame and the zero-th sample.

Samples per Frame |1 Zero-th Sample |1
Impart | Cancel |

Figure 8

In the Data Information frame [ Figure 9 ], check the boxes marked First Field Contains:
and Second Field Contains:. Leave the other dialog properties at their default values.

Diata Infarmation
hether any initial columns contain special information nat to be graphed.

I¥ First field contains : “ Sample Number ¢ Time*
¥ Secgnd field contains : " Sample Number ©* Time*
i éz will be uzed ta verify the zero-th zample, but are not uzed for alignment.

The data may have been sampled at a faster rate than the video.
To align video and data, indicate the samples per frame and the zero-th sample.

Samples per Frame |1 Zero-th Sample |1
Figure 9
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Confirm your import settings by clicking the Import button located at the bottom of the
dialog. The Measurement Window will automatically update to display a graph of the
imported data in the Graph window pane.

Press the ™ button and take note of the movement of the tracking line through the Graph
window. You will see that it only proceeds a short distance through graph before the video
ends. This is because by default, ProAnalyst synchronizes data to the video frame rate.
However, in this example, the data was recorded at a higher rate than the video.
Fortunately, it is possible to synchronize video with external data that was recorded at a

different rate.

Reopen the Import Data window. ProAnalyst will ask if you would like to replace the
currently existing data. Click Yes. When the Import Data window opens, repeat the previous

steps taken to import and configure the data file, but do not click the Import button yet.

Above the Import and Cancel buttons, you will notice two text boxes labeled “Samples per
Frame” and “Zero’'th Sample”. The values contained in these boxes are used to determine
how imported external data should be synchronized with the current video. As the
accelerometer data in this example corresponds to 25 data points for each frame of video,
change the “Samples per Frame” field to “25” [ Figure 10 ].

The data may have been sampled at a faster rate than the viden
To align video and datashdicate the zamples per frame and the zero-th zample.

Samples per Frante Zero-th Sample |1

Cancel

Figure 10

Clicking the Import button now will cause ProAnalyst to properly synch up the video and
data. This can be confirmed by pressing the * button on the video controls. You will see
that the frame tracking line moves through the graph at the same rate as the video
playback. Click the & icon on the Measurement Window toolbar to close the graph

window for the time being.
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Step 4 — Calibrating an Image

By default, all position, velocity, and distance data associated

with a tracked feature is calibrated to pixel scale. ProAnalyst

. . . Multi-Plane Calibration
is able to calibrate a video to real world scales (feet, meters, —
etc) based on either Normal (i.e. orthographic) or Perspective

calibration models. In this example, the default Normal Calbrafions

Add Perspective |

calibration will be used to transform the video coordinates into

meaningful real-world coordinates. Il
Open the Multi-Plane Calibration control panel by clicking
on the "% button located on the Analysis Modules/Tools
toolbar.
Set s Default Remave
A Normal calibration requires the specification of two points of Deserption
reference within the video that have a known distance Type:  Momal
between them. The distance between these two points is Mat Calibrated

specified in calibrated units, and ProAnalyst converts the
pixel length to calibrated units appropriately. In this example,
the bottom of the car’s chassis will be used as a reference

object for scale calibration.

Click the % icon to open the Calibration Settings window. At

Calibrate

Set Point #1

the top of the Calibration Settings window, you will see two Set Point #2
buttons labeled Set Point #1 and Set Point #2 [ Figure 11 ].

Below these two buttons is a text field in which a calibration value

15 Inches

Apply Scale >3 46 pisels Jin
can be input, as well as a dropdown menu containing different
) . . Calibrate Coordinate System
real-world units of measurement that can be applied to the video
. Figure 11
image.

Advance the video to frame 21. Position the reticle by clicking at the bottom rear corner of

the car’s chassis {Figure 12 ]. When it is positioned, click the Set Point #1 button.
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Figure 12

Reposition the reticle at the bottom front corner of the chassis [ Figure 13 ], and click the Set

Point #2 button.

Figure 13

After both calibration points have been set, input “2.25” (the
approximate width in inches of the car’s chassis) into the
Distance Between Points text field [ Figure 14 ], and click
the

Apply Scale >> button to set the new calibration value. You
will see the “pixels / in” value change to reflect the new
calibration scale factor, and ProAnalyst will automatically
apply the new calibration to any measurements that are
recorded.

Calibrate Scale

Set Point #1

Set Point #2

Eetween Points

Calibrate Coordinate System

Set Origin | Set ¥ Direction | Flip ¥ dis |

Figure 14
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Step 5 — Manipulating an Image with Processing and Filters

Before tracking the motion of an object, it is often advantageous to apply a series of
processing or filtering operations to an image. This example will demonstrate how the
application of only two operations can significantly enhance the video image, such that

several distinct features of the car can be easily tracked in the next section of this tutorial.

Image Processing

The Image Processing (LUT) control panel allows you to modify the display settings of an
image. Two identical sets of sliders are available, one for Color Image Settings, and one for
Black and White Image Settings (B&W). The B&W Image Settings sliders are grayed out by
default, and will not be used in this example.

Open the Image Processing (LUT) control panel by clicking the Color Image Settings

® icon on the Analysis Modules/Tools toolbar. Move the Highire:s of [ 2

“Exp./Log.” slider [ Figure 15 ] to the left by clicking and Em"a“ | “ g
amma \II—/

dragging it with the mouse. This has the effect of making dark EHp.JLD@
regions in the image darker, while simultaneously bringing out R L

more detail in the lighter regions.
Figure 15

Image Filtering

The Image Filtering control panel allows you to apply a series of image processing filters to
a video image. This process is analogous to applying signal processing filters to electronic
circuits. The Image Filter List portion of the panel lists in descending order the current filters
that have been applied to an image. Filter results are calculated in the order in which the

filters are added.

. . . s g, 4
Open the Image Filtering control panel by clicking the *~& icon on  [EEEElElEEEEL
= Convolve ~
the Analysis Modules/Tools toolbar. Filters can be added to the E:Z’ﬁfi'éf?i;iﬁfs-'?@im
. . . . . [ ertical Edges [3x3 Sabel)
list through the Select Filters to Add dialog [ Figure 16 ]. Click the I Horsoma E s (3 Sabal
I £ dge Detector (33 Laplacian High P.
Add button to open the selection window, and expand the Egdﬂege‘mﬁﬁ Laplacian High P
moothing (3x3 Gaussian Low Pass]
« " L. . . 1 S oothing (545 Gaussian Low Pass)
Convolve” list by clicking on the + sign next to it. [ e Detoctr (3 Contr bigh Pacs
D E dge Detector (545 Center High Pass
L . I Checker Comer Detector v
Click inside the box labeled “Sharpening (3x3 Center)”, and then ¢ >
. . . . 0K C. |
press the OK button to apply the filter. Clicking Cancel will close [ ] _coos

Fi 16
the window without implementing any filters that may 'gure

have been checked.
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You may compare the original [ Figure 17-A ] and the processed and filtered [ Figure 17 -B ]
versions of the video by clicking back and forth between the Raw and the Processed tabs.

Sirh:

Figure 17-B

Step 6 — Tracking a Simple Feature

“Tracking” is the ability to select a distinct feature and determine its motion characteristics
over time. A feature is defined as a rectangular region within the initial frame of a video. The
Feature Tracking control panel allows users to specify whether they would like to track a

feature manually, or allow ProAnalyst to conduct an automatic track of a feature.

Manual tracking allows a user to step through the video one frame at a time while using the
mouse to select the location of the feature in each frame. This method is generally
employed for low-quality images, or when highly irregular motion paths are present.
Auto-tracking is the ability of ProAnalyst to automatically find and track user defined
features, and then determine frame-by-frame motion characteristics with respect to the
image plane. This automatic tracking capability will be demonstrated by tracking two
features on the car is it moves through the video — in this case, the number “3” painted on

the car door, and the accelerometer mounted on the windshield.

To track the “3”, begin by clicking the 2} icon to open the Feature Tracking control panel,
and then click the Enable button at the top of the control panel to activate the panel. Notice

that one feature is automatically added to the Features list.
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ProAnalyst will begin auto-tracking on the currently displayed video frame. Click the Ied

button to move the video to frame 0, if it is not there already.

The next step is the definition of a template representing the object you wish to track. Click
the Define Region button, located at the bottom of the Features frame, and then click and

drag the mouse to draw a box around the number “3” [ Figure 18 ]. After the box is drawn, it

can be repositioned by clicking and dragging it to a new location on the image.

P

" Figure 18

With the tracking template defined, click the Set Region

Features

Add | Hemnve| Clear |
r1| olabel> | 4 [By 5 9y

button. The box will change color and display a small number

1, indicating that it is the first feature in the feature list. In the

feature list, you will note that the new feature is titled “<no
label>” [ Figure 19 ]. A feature settings window can be opened Figure 19

by clicking the @, icon associated with a feature.

The Track Settings window provides access to all the parameters involved in auto-tracking.
Type some text (for example, the word “Three”) in the “Feature Label” text field to define a
label for the feature. The other parameters in the window may remain at their default values.
Click the Apply button, followed by the Close button at the bottom of the dialog. The new

title will now be displayed above the bounding box surrounding the selected feature.

New features can be added to the window by clicking the Add button. Add a new feature to
the list, and then define and set a template for the accelerometer mounted on the windshield

of the car. Open the Track Settings window for this feature, and type a label
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(“Accelerometer”, for example) in the “Feature Label” field. Your image should now

resemble Figure 20.

Acgelerometer

Figure20
When you have defined and set both template regions, click the Track Forward button. The

video will advance frame-by-frame as ProAnalyst tracks the selected features and marks

their positions on the screen [ Figure 21 ].

Figure 21
By default, ProAnalyst will display every tracked point on the ver e | ownen |
screen simultaneously. Depending on what frame you are on in Featue Lines Shgu Prin
the video, seeing all of the tracking marks can be visually Configurs @
confusing. Below the “Features” frame is the “Show Points” T'Tackilngn L
pull-down list [ Figure 22 ]. Click on the pull-down list and select Figure 22

the “Show Past” option. This option will only display the tracking
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points associated with the current frame, as well as any previous

frames.

Viewing Real-time Measurements

The Show Measurements window provides real-time motion analysis results, such as
current position and velocity, for each feature being tracked. It can be opened by clicking

the B button on the Measurement Window toolbar.

Measurement values can be added through a selection window

- T——rT—
that is opened by clicking the = icon on the Show =
Measurements window. In the selection window, expand the :::z:;g:rcjimmeten
“2D” list and click the boxes next to “Feature 1 (Three)” and
“Feature 2 (Accelerometer)” [ Figure 23 ]. When you have Figure 23

selected the values you wish to display, click the OK button.

i demo_holwheels.avi - Measurements

Measurement values are displayed in pixels by default. To |

Identifier

2D - Feature 1[Thiee] e
20 - Feature 2 [hoceler b

view real-world calibrated measurements, select a calibration

unit from the Units: drop-down menu [ Figure 24 ].

Figure 24

Step 7 - Graphing Video and Data Analysis Results

ProAnalyst allows immediately plotting of any tracked data, as well as associated sensor

data. You may open the graph pane by clicking the & icon. When the graph is opened, you
will see the data from the accelerometers that was plotted when the external sensor
readings were imported into ProAnalyst [ Figure 25 ]. The accelerometer sensor channels
are plotted in the same colors (red and green) as the tracked points in the video window. To

avoid confusion, the colors used to plot the sensor data will be changed.
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Figure 25

Begin by clicking the Miconto open the Graph Configuration control panel. Double-click the
mouse on the red dot next to “Data — Channel 0” in the Graph Lines frame to open the

Graph Line Appearance window.

Graph Line Appearance

Click on the “Color” box to open a color picker [ Figure 26 ].

Channel: Diata - Charel 0 (]

Choose a new color for the graph line (blue, for example) and

Line Properties Faint Properties
click OK to close the color picker. Click Apply, and then OK to sy [said x| | sy [Hene ]
p pp y Calor || Colar ||
apply the new color. Thicknsss [1__7]
Repeat the preceding steps to change the plot color of “Data — 3 carcel | amoy |

Channel 1” (to yellow, for example).

In terms of tracked data, it is possible to plot the X and Y positions of any tracked points, as
well their instantaneous speed, and distance from the origin. For this example, the speed of
both tracked features will be plotted alongside the accelerometer data. Before plotting the
tracked points, confirm that the “Units” drop-down menu located in the Feature Tracking
control panel is set to the calibration units of your choice, otherwise the graph will be

displayed in pixel units by default.

Open the Select Items to Add to Graph window by clicking the Add button in the Graph

Lines frame. You will note that the selection window is of a similar configuration to the image
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filtering window used previously. Expand the 2D list, and check [~ “ttid
the boxes next to “Feature 1 (Three) — Speed” and “Feature 2 ) ZDEEZZEE:ZW:ZZ%Zi
(Accelerometer) — Speed” [ Figure 27 ], then click the OK B =

button. ﬁ EZ:E::Z ===

Cancel
Figure 27

Your graph will now display a plot of the speed in inches/sec of your two tracked features,
as well as the imported accelerometer data. However, you will notice that the new graph
lines are plotted in the same colors (blue and yellow) as the sensor data plot lines. Follow
the steps above to change the colors of the feature speed graph lines so that they match

the colors of the tracked points in the video image (red and green) [ Figure 28 ].

1.2
Time [seconds)

Figure 28

Step 8 — Adding Notes and Annotations to a Video

Video Annotations

Annotations provide the ability to overlay your own labels, measurements, or other objects
directly onto a video sequence. These annotations can be configured to display on every
frame of a movie, or can be limited to a specific frame or frames. Annotations are managed

through a control panel which can be opened by clicking the * icon.

i1

Go to frame 0 of the video, and the click the = | (Draw Length Dimension) icon. Length

dimensions are strait lines drawn between two points within the video. The length of the line
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will be displayed in calibrated units. To draw a length dimension, click and drag a line along
the bottom of the track from the edge of the screen to the lego wall [ Figure 29 ].

Accelerometer

" Figure20

After the line has been drawn, its length and position can be altered by clicking and
dragging the control points at either end to adjust the positioning of the endpoints. The
length dimension can be moved as a unit as well. Click and drag the Length Dimension to
line it up with the bottom of the track [ Figure 30 ]. Click anywhere in the video frame to
deselect the Length Dimension.

Accelerometer

Figure 30
Advance the video to frame 25. Draw another Length Dimension, this time positioned along
the bottom of the car [ Figure 31 ].
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Figure 31

Video and Data Notes

ProAnalyst allows users to keep a running log of notes, journal
entries, personal findings, and thoughts in an internal
application notepad. This information is stored with the project
such that only qualified users are able to edit journal entries.

The Notes control panel [Figure 32 ] may be opened by clicking

the = icon.

In the “Global Notes” text frame you may input any descriptive
text that applies to the entire video and data sequence. For
example, input the date, the video name, the experiment

number, and a description of the test.

Set the video to frame 25. Input a comment regarding the
impact of the car to the wall in the “Video Notes” text frame.
These notes will only be visible when the video is on the frame
in which they were input.

Show Motes Step
v Videa [ >
v Global EI—‘

Wideo Motes

Global Motes

Figure 32

Repeat the previous step for as many other video frames you would like to add notes to.

After you have added multiple notes to the video, move to frame 0.

Clicking the Step buttons at the top of the control panel will allow you to automatically cycle

through each video note, without having to use the video controls.
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Step 9 — Generating a Report

ProAnalyst has the ability to automatically generate a report based on video, data,

analysis, notes, and annotation content. Reports are assembled and output in a structured

format suitable for printing and web distribution. Currently supported formats include Print,

HTML, and PowerPoint. HTML reports can be opened in all Office products, including Word,

Excel, and Front Page, as well as Internet Explorer, Netscape, and other web browsers.

Reports include a cover page that displays the video and data information, an image of the

first video frame, a graph of any plotted video or data information, and any global note

associated with a video [ Figure 33 1.

To generate a report, select Tools 2>
Generate Report from the main menu bar.
This menu option will open the “Generate
Report” dialog box. The dialog box is
comprised of four tabs, each of which
handles a different aspect of report

generation.

In the Definition tab, select an HTML output
format from the “Type” drop-down menu.
With an output format defined, click the
Browse button, located next to the
“Filename” text field, to bring up a save box.
Input the name you would like your report to
be saved under and press the “Save”

button.

Click on the Setup tab. Select the All Corresponding
Data button [ Figure 34 ]. This will output the data
points that pertain to each frame that is displayed in the
report. Click the Generate button. Your report will

appear on the screen in your default internet browser

(i.e. Netscape, Internet Explorer, etc.).

Report: C:\Documents and Settings\My Documents\ProAnalyst\ProAnalyst
Documentation\Tutorials\Tut01_Learning_ProAnalyst\Demo_Files\demo_hotw

Video : demo_hotwheels avi
Record Rate : N/A
Number of Frames: 73
Dat: e : 25 Hz

Samples Per Frame : 25
Total Samples : 1825

‘ |

. iAWWMW.,MmWWWM: ‘Mmqg%mu At AxWWWM«w\»WW

hed into a forboding
2d from lego blocks.

Figure 33

Generate Report @‘

Destination  Setup IViden | Data |

[¥ Print cover page [containg global note]
v Print page header

v Print page footer
Include

[™ Frames with notes Ol datawithnnte
[~ Every |5 ﬂframa[ (+ Al corresponding data

Figure 34




Tutorial 1: Learning to Use ProAnalyst 91

Step 10 — Saving Your Work

The final step in learning ProAnalyst, is an understanding of the way in which ProAnalyst
saves and manages tracking data, calibration, etc. As a rule, ProAnalyst does not
arbitrarily modify video or data files. Rather, ProAnalyst incorporates a series of individual

save files that correspond to analysis, image processing, and other operations.
Click on the Project Window to make it active. Select File > Save to save your project file.

Click on the Measurement Window to make it active. Annotations may be saved by
selecting File > Save Annotations, while notes may be saved by selecting File > Save
Notes. Notes and Annotations will automatically be loaded when the saved Project file is

opened.

Synchronized Data may be saved by selecting File>Save Modified Data. This operation

will not overwrite your original data file.

Image Processing, Image Filtering, Image Calibration, Graph Configuration, and Feature
Tracking each have save buttons on their respective control panels. Likewise, the E icon at
the bottom of the Measurement Window tools palette can be used to save any files that

have been modified over the course of an analysis.

ProAnalyst writes its operation save files into whichever directory your project file is saved.
By default, save files take the name of the video they are associated with [ Figure 35 ], but

may be renamed at your discretion.

‘ofnalyst\Prodnalyst Documentation) Tutarials\ Tut01 _Learning_ProAnalystiDemo_F

Mame Size  Type
Jdemo_hotwheels_imgs File Folder ¢4———— Report Images
=l dema_hatwheels,ant 1KE ANT File +#——— Annotations
|t dema_hatwheets, a3 1KE AU3 File #————— User Notes & Per Frame Information
= dema_hatwheels Frk 21KE FTK Fils #————— Feature Tracking
£ | demo_hotwheels, html 16 KE HTML Document —— HTML Report
ﬂ demo_hotwheels.imp 1KE IMP File #——— Image Filtering
| demo_hatwheets.lut 1KE LUT Fle +——— Image Processing
J demo_hotwheels, auz 90KB MiDAS Data File #—— Modified Data File
) Haotwheels. mpj 1 KB Project Document #— ProAnalyst Project File
dermo_haotwheels_data,bxt 83 KB  Text Document
(=2 demo_heartwalse, avi 14,626 KB Video Clip Original Video
(=2 demo_haotwheels, avi 6,394 KB Mideo Clip and Data Files
(=2 demo_waterdrop, awvi 29,066 KB video Clip

Figure 35



Tutorial 2: Tracking Featureless Motion
with the 1D Line Tool

This project showcases the ability of ProAnalyst to analyze what is known as “featureless
motion”. In this example, an analysis is performed on the process of fuel combustion in an
engine. Combustion has no distinct features, per se, that can be tracked, however, we can
use the unique 1+D Line Tool to track the leading edge of a flame front that is expanding
out from the center. Note that the 1¢D Line Tool is not available in the ProAnalyst Lite
Edition.

Files Needed for This Tutorial

1. flame.avi

Step 1 — 1D (Line) Tracking

The 1D Tracking module is capable of detecting peaks or derivatives of intensity along a
line. 1D Tracking is also able to detect points of transition that exceed a configurable
threshold value for intensity or derivative of intensity. These transition points can then be
used to calculate a best-fit circle. We will use this capability to track the leading edge of the
flame front by analyzing the black-to-white threshold derivative along three lines, while a

circle fit is used to estimate the radius of the flame front as it expands.

Begin by creating a new ProAnalyst project, and add the flame.avi movie file. Open the

Measurement Window.

Open the Line Tracking control panel by clicking the D' icon on the Analysis
Modules/Tools palette, and then click the Enable button to activate the control panel. A

tracking line will appear in the center of the video window [ Figure 1 ].
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Figure 1

To reposition the tracking line, click the Modify Line button. Click and hold down the left
mouse button over the position where you want the line to begin. Without releasing the
button, drag the mouse along the video image to the position where you want the line to

end. You should see the line redraw along the path you followed [ Figure 2 ].

Figure 2

When you reach the end point you want, release the mouse and click the Set Line button.
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Additional lines can be placed by clicking the Add button. Add two more lines to the image
and repeat steps 3-6 for each one. Your video image should resemble Figure 3.
Note: The numbers next to the lines in Figure 3 denote the order in which they were added

to the project. These numbers do not appear in ProAnalyst.

Figure3

Click the Track Forward button to begin the line tracking.

In this particular example, the best fit circle can be used to gauge the accuracy of the line
tracking. As the video tracks forward, it will be obvious that the default settings for the line

track (specifically Line 1) are not adequate for the analysis and must be modified.

Figure4
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To modify its tracking parameters, select Line 1 in the properties frame and click the By icon

to open the Line Settings window.

Search Parameters

. . . v Active Apply Settings to All Lines
Change the Transition Type from “Black to White” to “White to

Search Type Thresk T
Black” by selecting it from the dropdown menu [ Figure 5 ]. The Transtion Type
Threshold

“white to Black -

Maw. Targets 1 -
Click the Apply button, followed by the Close button to confirm Thickness 3 -
Filter Coefficient 1.00
your changes.
Figure 5

other Search Parameters can remain at their default settings.

Repeat the previous procedure for Line 2, but do not change the Transition Type option.

Instead, set the Threshold value to “40”. Line 3 can remain with its default values.

Click the Track Forward button. You should now see a more accurate track of the flame

leading edge. Figure 6 shows frame 30.

Figure 6

After tracking has been completed successfully, the change in size of the radius, as well as
the radial speed of the best-fit circle can be plotted as new graph lines. Refer to Tutorial 1,

Step 7 for information on graphing tracking results.



Tutorial 3: Analyzing the Motion of a
Rotating Object

This tutorial will explore on one of the most powerful features available in ProAnalyst,
namely the ability to rapidly track objects that rotate, as well as, move linearly within the field
of view. In this example, the following marks were drawn on a CD ROM: an X’, a line, and a
star pattern. ProAnalyst was used to automatically track both the linear and rotational

motion of these objects and graph the results.

Files Needed for This Tutorial

1. spindisksub.avi

Step 1 — Automatic Feature Tracking

Create a new project and add the spindisksub.avi video file. Launch the Measurement

Window, and then click the 2D icon to open the Feature Tracking palette. Activate the

control panel by clicking the Enable button.

Define and set a region around the feature you wish to track, in this case the ‘X’ [ Figure 1],
and then click the Track Forward button. The idea is to take note of the auto-tracking
results when feature rotation has not been enabled. It should be apparent by frame 4 or 5

that the rotational motion of the ‘X’ makes it extremely tricky to track automatically.

Figure 1
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Click the @ icon to open the Track Settings window. Activate Feature Fiotation
the Feature Rotation option by clicking in the “Enable” check z:iu::[a;j;[deg] ,_110
box [ Figure 2].

Figure 2
Input an “Angular Range” and “Step Size” in degrees. The
feature template will be rotated plus or minus the Angular Fe"““'e%'atz” o
% Enable ngular Range (deg
Range value in intervals of the step size. For example, a Step Size [deg]

rotational range of 30 degrees, combined with a step size of 5
degrees, will compare the template within a range of -30 to 30
degrees in 5 degree increments [ Figure 3 ]. Click the Apply

button, followed by the Close button to confirm your changes.

Press the Track Forward button, and you will see the ‘X’ accurately auto-track [ Figure 4 ].

il

Figure 4

Step 2 — Analyzing the Rotation of the Tracked Feature

To accurately graph the rotational motion of an object, it is necessary to calculate the angle
of rotation relative to a central origin point. As the ‘X’ is drawn on the disk, it makes sense to

define the center of the disk as the origin.

Click the ¥ icon to open the Image Calibration control panel. Position the reticle on the
center of the disk. Click the Set Origin button, followed by the Apply Origin and Tilt >>

button, to define the center of the disk as the new origin [ Figure 5 ].
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Figure 5

To plot the angle of rotation, reopen the Feature Tracking control panel, and then open the

Line Configuration window [ Figure 6 ] by clicking the Configure button.

Line Configuration F§|
Line Murnber |1 - Add Line | Remove Line |
Line Properties
Display Lines | Cumrent Frame Stle | Solid -
I~ Highlight Line in Current Frame ~ Color [ | Size (2
D efine Line Measurements
Possible Sequence of ; 5
Bl [ g i3how Angle Measurements
Feature 1 Featue 1 ™ Show Length Measurements
Origin v
Huorizontal- Horizontal+
Wertical+ ﬂ £
Yertical- -
Origin ﬂ
e+ Direction Font
7 Direction - - -
v+ Direction 1 Family | Aisl
V- Direction g | Coor NI size [16
v Bold [ ltalic [ Underline

Apply | Cloze |

Figure 6

)

First, click the Add Line button. Next, move “Feature 1”, “Origin”, and “X+ Direction” (in that
order) from the “Possible Points” list to the “Sequence of Points in Line” list. Finally, check

the box labeled “Show Angle Measurements”. Click the Apply button, followed by the Close
button.
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When the Apply button is clicked, an angle will be drawn between the three specified

points. This angle is updated in real time as the video is played back [ Figure 7 ].

‘ A E".
Figure 7

Angle measurements can be graphed in the same manner as speed or position

measurements. Begin by clicking the M icon to open the Graph Configuration control

panel.

Click the Add button to open the Select ltems to Add to Graph
[ Figure 8 ] window. Next, expand the “2D” list, and check the
box labeled “Feature Line 1 — Angle”. Click the OK button to

confirm your selection.

The Graph window pane will appear and display a plot of the

Angle Measurement value vs. Time [ Figure 9 1.

Select Items to Add to Graph

=-2D
Ol Feature 1()-%
OFeature 107
| Eale L
[ ]

-

Feature 1
F

Cancel

Figure 8
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Figure 9




Tutorial 4: Stabilizing a Shaking or
Vibrating Video

Camera shake and vibrating objects are common problems faced by many image analysis
professionals. The ProAnalyst Stabilization Module provides a solution to this problem by
providing the means to stabilize shaking or vibrating video images, simulating video
acquisition by a stationary camera. This process is accomplished by locating and tracking
video features that should maintain a stationary position. The shift and rotation necessary to
maintain the features in a fixed position can then be computed, allowing stabilization to be
performed for any combination of unwanted horizontal, vertical, or rotational motion. Note
that the Stabilization Module is an optional toolkit, and may not be included in your version

of ProAnalyst.

Files Needed for This Tutorial
1. demo_jittery.avi

Step 1 — Processing the Image for Feature Tracking

Create a new ProAnalyst project and add the demo_jittery.avi video file. Launch the
Measurement Window, and then click the ® icon to open the Image Processing control
panel. The first step in processing the video image will be the conversion of the color image

[ Figure 1] to black and white.

Figure 1



Tutorial 4: Stabilizing a Shaking or Vibrating Video 101

Click the Display B&W button. Adjust the B&W Image Settings sliders until several

features within the image become clearly defined [ Figure 2 ].

Figure 2
Step 2 — Stabilizing the Video Sequence

Many of the features of the Image Stabilization module are based on the same underlying
concepts as the Feature Tracking module. Stabilization requires the definition of a number
of high-contrast regions within an image which can be tracked from frame to frame over the

course of the video sequence.

Click the ™. icon to open the Image Stabilization palette, and then click the Enable button
to activate the control panel. Note that a “Stabilized” option has been added to the video
view tabs. Add, define, and set three features corresponding to three visually contrasting
regions of the image [ Figure 3 ].

Figure 3
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Click the © icon associated with Feature 1 to open the

Stabilization Feature Track Settings window [ Figure 4 ].

Set the “Search Region Multiplier” and “Limit on Distance From
Last” text fields to 700.

Set the “Threshold Tolerance” to 0.85.

Click the Apply button followed by the Close button to confirm
your settings, and then click the Track button. If any of your
features are lost you may redefine them and hit Track again to

repeat the process.

Stabilization Feature 1 Track Setti... \Z

~Image Settings

Show Settings | Apply Curent to Feature |

¥ Use image processing filkers

i~ Search Parameter

Search Region Multiplier [>100%) 700
Threshald Talerance [0.0-1.0) 0.85
Limit on Distance From Last (%] 700

1]

Frames to Search After Loss

¥ Sub-pikel accuracy | Enhanced match

i~ Feature Rotation

Angular Range [deg] 10
I Enable
Step Size [deg) 1

Trajectary Prediction
’Vl' Ensble [ EnsbleY [ EnableR

Apply | Drefault | Cloze I

Figure 4

When the feature tracking has been completed successfully click the Stabilize button. The

Measurement Window will automatically switch to the “Stabilized” view [ Figure 5 ].

Figure 5

Press the ™ button to view the stabilized version of your video. You will notice that each

stabilized frame will be drawn over the top of the previous frames [ Figure 6 ].

.y
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Step 3 — Saving the Stabilized Video

Before performing any kind of tracking or analysis on the stabilized video, it must first be
saved as a new file. You can then add the stabilized video to a new or existing project to

and continue with your analysis.

Click the Save Stabilized Video button to open the “Save
Video” dialog box [ Figure 7 ]. The default file name will be the

name of your video with the suffix “_stab” appended to it. This

is not mandatory and may be changed at your discretion.

After modifying any video parameters that you wish to change,

click the Save button to save your video file. ProAnalyst will

automatically open the newly saved video in a new B e s

Measurement Window. Fi
igure 7



Tutorial 5: Analyzing Particles in a Flow
Environment

This tutorial describes the ProAnalyst Particle Toolkit, and the steps necessary to count,
size, and analyze particles in a video sequence. Note that this tutorial makes use of features
found in the ProAnalyst Professional Edition, as well as the optional Particle Counting and

Sizing Toolkit.

Files Needed for This Tutorial

1. spray_bottle _droplets.avi

Step 1 — Filtering the Image

Create a new ProAnalyst project and add the spray_bottle droplets.avi video file to it. Open
the Measurement Window and play through the video. You will notice that the background is
not uniform towards the top of the image [ Figure 1 ]. Likewise, the particles flowing through
the video vary in terms of size and visual intensity. In order to accurately analyze this video

sequence, it will be necessary to isolate the desired particles in each frame.

- L ]
Figure 1

To isolate the desired particles, a series of image processing filters will be applied to the
video image. In this example, only the clear, in-focus particles in the video frame are of any

interest. Accurately tracking these desired particles will require the elimination of pixel noise



Tutorial 5: Analyzing Particles in a Flow Environment 105

in the image, as well as undesired particles that may be present in any given frame of the
video. Refer to the ProAnalyst User Guide for more detailed technical descriptions of the

filters used in this tutorial.

Mg
To begin, open the Image Filtering control panel by clicking the ‘”u icon. Click the Add
button to launch the filter selection window. Expand the LUT list, and select the Reverse

filter. Click the OK button to add the filter to your project.

A Reverse filter inverts the pixel color values in every frame of a video, effectively creating a
“negative” version of the video [ Figure 2 ]. The rationale for using this filter is that it will be
far easier to isolate and track bright particles on a dark background than vice versa.
Likewise, it will be necessary to filter out the background noise present in the upper part of

the video image. Applying the Reverse filter simplifies this task considerably.

Figure 2

After the application of the Reverse filter, isolating the particles

and filtering out the background noise can be accomplished by
1lier setlings
applying a Common > Threshold (Binary) filter. This operation Py Tt )
Froperties
creates a black and white version of an image by setting each pixel 23::: ,%
with a color greater than a certain value (the “threshold” value) to ke =
white, while any pixels with a color less than the threshold value are Sefeot Coor Under Refice
set to black. The threshold values used by this filter may be modified e —————

through the Filter Settings window [ Figure 3 ]. This window can be

accessed by clicking the % icon next to the threshold item in the filter

list.
0K Cancel ‘ Apply

Figure 3
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By applying the Threshold filter after the Reverse filter, the situation is such that the

particles of interest remain visible, while any background noise is eliminated [ Figure 4 ].

Figure 4

As effective as the Threshold filter is in differentiating the particles of interest from the

background, it did leave an artifact in the form of a white line across the top of the video

image. Fortunately, another filter is available to eliminate this artifact.

Click the Add button, and select the Common = Zero Border filter.
This filter creates a black border around the edge of an image. The
number of pixels along the top, bottom, left, and right of the image
that are affected by the filter can be modified in the same way as the

threshold value.

Click the % icon to open the Filter Settings dialog box. The default
settings for Zero Border generate a border five pixels wide. As the
white line is only present across the top of the image, change the
“Left Border”, “Right Border”, and “Bottom Border” values to 0. The
strip at the top of the image is only one pixel wide, therefore the “Top
Border” value can be set to 1 [ Figure 5 ]. Click the Apply button,
followed by the OK button.

Filter Settings @

Filter: Zero Border
Froperties
Left Barder
Right Border
Top Border

T

Eottom Border

Preview
[ Enable Preview [ Auto Update

0K | Cancel | Apply

Figure 5

With the application of the Zero Border filter [ Figure 6 ], the video is now ready for

automatic particle analysis.
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Figure 6

Step 2 - Tracking and Computing Statistics of Particle Flow

Open the Particle Tracking control panel by clicking the ‘s icon, and then click the Enable
button at the top of the palette to activate it. The Particle Tracking control panel contains

several default parameters that can be configured based on

specific analysis requirements. Parameters
+ Bright Particles Dark Particles
Threshold: 64
Set the “Minimum Size” field to 5, the “Maximum Angle” field = m_o )
ilkers: Size Angle Eccen
to 180, and the “Maximum Eccen.” field to 200. Click the Label Minimum |5 80 A
i . . . . b 2 5l
field, located in the Display frame [ Figure 7 ], to uncheck it. e 160 20
Displa
When the parameters have been set, press the Track @ . )
v Center of Gravity v Major Axes
Forward button. v Particle Qutlines Sumirnary
Figure 7

As the video advances frame by frame, ProAnalyst will outline any particles that fall within

its defined parameters [ Figure 8 ].



108 ProAnalyst Tutorial Guide

Figure 8

Click the Raw video tab to see the results of the particle track on the unprocessed video

image [ Figure 9 ].

= =
dy T

x® |

_|_

+
+*+

Figure 9

Step 3 — Data Filtering
Data filters are accessible via a popup dialog located within the Graph Configuration
control panel. A listing of Graph Lines is located within the center frame of the Graph
Configuration panel. The columns within each listing display the item number, item
description, line color, visibility, and filter settings. The filtering options for a given line can

be accessed by clicking on the filter settings icon in the last column.
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Open the Graph Configuration control panel by clicking the m
icon. Click the Add button to create a new graph object, and then
select Particle > Num Particles from the Items to Add window

[ Figure 10 ]. Click the OK button to confirm your selection. The

graph pane [ Figure 11 ] will immediately update to display the

new plot line.

Select Ttems to Add to Graph

=I- Particls

Ol AvoAngle
[O4vgEccen

Cancel

Figure 4

|
0 0.05 0.1 015
Time [zeconds]

Figure 11

To apply a data filter to the plot line, select the “Particle — Num Particles” channel in the

Graph Lines list. Click the ]

Click the checkbox labeled Enable Filtering.

Click the Add button to create a new data filter.

Select the “Empty Filter” item [ Figure 12 ].

In the Properties frame, located beneath the Filter List, is a

dropdown menu titled Type. Open the menu and select Low

Pass from the list [ Figure 13 ].

icon to open the Graph Line Filtering window.

Filter List
Add Remave | Clear ‘

Properties

Type Select Type «
Style Select Type A
Order High Pass

Band Pass
Figure 13
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Selecting a Filter type will activate the next dropdown menu Type LonPas: <]
g yp p ’ Style Select Style »
Style. From this menu select a Butterworth filter [ Figure 14 ]. Order
Cutoff Freq. .

Figure 14

Click the Apply button, followed by the Close button. Your graph will automatically update

to show the results of the filter on your plotted data [ Figure 15 ].

28+

26

24—

I
0 0.05 01 015 0z 028
Time [seconds]

Figure 15

It is possible to compare the filtered graph with an unfiltered version of the same data. To do

this, create a new channel by clicking the Add button.

Repeat the previous steps to select and display another plot of the number of particles in

each frame.

As graph lines are drawn on the screen in the order in which they are added, it is very likely
that the filtered plot will be almost completely obscured by the unfiltered plot [ Figure 16 ].
This can be remedied by removing the filter from Channel 1, and applying it to Channel 2

instead.
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Figure 16

Open the Graph Line Filtering window for Channel 1, and then uncheck the Enable Filtering
box. Click the Apply and Close buttons to confirm this action.

Open the Graph Line Filtering window for Channel 2, and repeat the previous steps to apply
a Butterworth filter to the plot line. With the filter applied, you should see a visually less

confusing plot of both the raw and filtered graph data [ Figure 17 ].

1] 0.05 01 015 0z 025
Time [geconds]

Figure 17



Tutorial 6: Analyzing Size and Shape
Changes in Blob Objects

This tutorial describes the ProAnalyst Contour Tracking Toolkit’s ability to identify,
track, and analyze objects whose shape changes over time. In this example, the surface
area, shape, and location of a water drop are analyzed as it falls through the video frame.
This method can be used to analyze airbags, blobs, pills, coatings, particles, or other
variably shaped objects. Note that this tutorial makes use of features found in the

ProAnalyst Professional Edition, as well as the optional Contour Tracking Toolkit.

Files Needed for This Tutorial

1. testmagdrop1.avi

Step 1 — Image Filtering
Create a new ProAnalyst Project and add the testmagdrop1.avi movie. When you open the
Measurement Window, you will notice that the water drop is not visually distinct from the

spout [ Figure 1 ]. The first task is to apply a series of image processing filters with the goal
of isolating the water drop from the rest of the image.

Figure 1
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e
Open the Image Processing control panel by clicking the ~Z icon. Image filters are

calculated in the order they are applied. As you proceed through this tutorial, feel free to
experiment with an alternate sequence of image filters to determine their effect on the

overall goal of isolating the water drop.

Discriminating the Spout and Water Drop

The first step in the enhancement of the outline of the spout and water drop from the

background will be the application of an edge detector.

Click the Add button in the Image Filter List frame to launch Select Fillers fo Add

the Select Filters to Add dialog. Expand the Convolve list i -
= Corwolve

and check the box next to Edge Detector (5x5 Laplacian [ Vettical Ediges (33 Preit)

[ Hotizantal Edges (33 Prewit)
[ ertical Edges [3x3 Sobel]

High Pass) [ Figure 2 ]. Press the OK button to confirm your [ Horizcreel Edges (342 Sabel)
[ Edge Detectar (3x3 Laplacian High P.
selection and apply the filter to the image. S0z Datector (528 Laplaoian High £

[ Smoathing [3x3 Gaussian Low Pass]
[ Smaathing (545 Gaussian Law Pass)
[ Edge Detectar (343 Center High Pass

The Laplacian High Pass filter is able to accurately highlight a2 bee e Ea e o
the edges of the spout and water drop. The tradeoff, however, Cancel

is the filter tends to generate a large amount of pixel noise in

the image [ Figure 3 ].

Figure 3
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To offset the background noise generated by the Laplace filter, apply a Convolve:
Smoothing (5x5 Gaussian Low Pass) filter. There will still be some noise present in the

frame [ Figure 4 ], but from a computational standpoint, it will be easier to minimize.

Figure 4

Apply a Common: Despeckle filter. Unlike the Edge Detection and Smoothing filters, the
Despeckle filter allows you to adjust the properties of the filter, thereby altering the effect of

it on the image.

Filter Settings
Click on the % icon in the Image Filter List to launch the Filter e e
Settings dialog box [ Figure 5]. :‘hmh":dulpltlf] ,EB—

Connectivity (4 or 6] EN
Change the Minimum # Pixels value to “24”. The Threshold value

should be set to “64”. The Connectivity value can remain at “8”. Preview

I¥ Enable Preview v Auta Update

Press the Apply button, followed by the Close button to confirm

your changes.

ox | [ cancel aoch |

Figure 5

Your image should now appear as an outline of the spout and water drop against an
otherwise black background [ Figure 6 ]. The final step will be the elimination of the spout,

effectively isolating the water drop in the image.
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Figure 6

Isolating the Water Drop

You will notice that the filters thus far applied to the image have produced an artificial border

around the edge of the image. This can be eliminated by applying the Zero Border filter,

found under the Common list. This filter provides an unforeseen advantage, in that with the

setting of one parameter, the filter can also eliminate the spout from the image.

The Zero Border settings dialog [ Figure 7 ] allows you to specify the
number of pixels along each edge affected by the filter. This provides

us with an easy method of eliminating the water spout.

Click on the % icon in the Image Filter List to launch the Filter

Settings dialog box for the Zero Border filter.

Change the values of the Left, Right, and Bottom borders to “3”.

Filter Settings

Filer: Zera Border
Propetties
Left Border
Fiight Border
Top Border

Buottom Border

Preview
Enable Preview

o) o) @@

Auto Update

Figure 7

By setting the size of the Top border to a large enough value, it is possible to eliminate the

water spout from the image [ Figure 8 ]. A value of “100” should be sufficient.
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Figure 8

With the outline of the water drop isolated, it is now a matter of filling
the outline so that the automatic tracking functions in ProAnalyst
identify it as one object. The Close Connection filter, located under
the Morphology list, is capable of connecting neighboring regions of
pixels by performing a series of dilation and erosion operations on the

image.

Apply the Close Connection filter and open its Filter Settings dialog
box [ Figure 91].

Filter Settings

Fiter: Close Connestions (Close)
Properties
Number of lterations 1

Preview
% Enable Preview ¥ Auto Update

Cancel Apply

Figure 9

Adjust the Number of Iterations value until the water drop has been filled and resembles

one solid region [ Figure 10 ].

Figure 10
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The final step in filtering the water drop for analysis is the application of an image threshold

filter. The threshold will set any pixels above a certain value to 255 (white). Pixels below that

value will be set to zero (black).

Apply the Threshold (Binary) filter from the Common filter list to the image. The default

filter settings will be acceptable. The final result will be a series of black-and-white frames

displaying the shape and motion of the water drop [ Figure 11 ].

Figure 11

Step 2 — Contour Tracking

With the water drop isolated from the rest of the image, it is now
possible to apply an automatic contour track to determine the drop’s

shape, location, and surface area.

Open the Contour Tracking palette [ Figure 12 ] by clicking the ©

icon, and then click the Enable button to activate the control panel.

The Contour Tracking control panel allows you to track the contour
of an object based on a number of parameters, including object size,
intensity, and last position. Click the 2 jcon to open the Contour 1

Settings window [ Figure 13 ].

Contour Tracking

Contaur Tracking Maode

© Manal
Load Save @« Avtomatic

Contours

Add | Hemove| Clear |
il &%
Tracking
Process Cument Frame |

Step Backward | Step Formard |
Track Backward | Track Forward |
Units & Expart
[ Export Contaur Points

Fivels  v||[Test =] Export

Figure 12
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For this example, two parameters will need to be changed. First,
select “Largest” from the Selection Type dropdown menu.
Second, set the Minimum Size parameter from “-1” to “300”.
Leave the other parameters at their default values. Click the
Apply button, followed by the Close button to confirm the
parameter changes.

Contour 1 Settings

Calibratian

Label  |Default i
Track Parameters
W active [

Selection Type Largest hd

Miriirnurn Size: 200
Maximum Size -1

Approach Direction | Left d

Threshald 128
Puint Spacing 5
Line Thickness 1

Apply | Default ‘ Close |

Figure 53

To begin tracking the contour of the water drop, press the Process Current Frame button.

You will see the water drop perfectly outlined in the frame [ Figure 14 ].

Figure 14

Press the Track Forward button. ProAnalyst will now automatically track the water drop

until it moves off the bottom of the frame.

You will notice that some frames contain particles that were not detected or tracked by

ProAnalyst [ Figure 15 ]. This is due to the Minimum Size parameter you specified earlier.
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Had that value been left at its default, the next largest object in the frame would have been

tracked after the main drop was no longer visible.

=110
gth = 1

Figure 15



Tutorial 7: Human Biomechanical
Analysis: A Rugby Kicker

The feature tracking capabilities available in ProAnalyst make it a powerful tool for
biomechanical analysis. In a lab setting, motion tracking markers make the process of
capturing an athlete’s motion extremely simple and efficient. Combined with ProAnalyst’s
automatic feature tracking, analysis results can be obtained quickly and efficiently, and may
exported to a variety of output formats. Stick figure rendering provides easy access to joint

angle measurements.

Files Needed for This Tutorial
1. Kick01.avi

Step 1 - Tracking the Hip Marker

A combination of automatic and manual tracking will be used to track the positions of four
markers attached to the rugby player’s hip, knee, ankle, and foot [ Figure 1 ]. While not
required by ProAnalyst, in many cases, the presence of these markers simplifies the

motion tracking process considerably.

Figure 1
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Create a new project and add the Kick01.avi video. Open the Measurement Window.
Note that the video has been recalibrated so that the first frame is numbered frame -47.
Click the »! button to advance the video to frame 0.

Open the Feature Tracking control panel and click the Enable button. Define and set a
region around the marker located on the player’s hip [ Figure 2 ]. Keep the region as close
to the size of the marker as possible to ensure accurate tracking results.

Figure 2

Click the % icon to open the Track Settings window and type “Hip” in the Feature Label text
field. Click the Apply button, followed by the Close button to confirm the new label.

Click the Track Forward button.

The hip marker should track accurately the first time through, as shown in Figure 3. If it does
not, you may redefine the feature and restart the tracking from the current frame.

Figure 3
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When you are satisfied with the accuracy of the feature track, click the # icon associated

with the feature.

Step 2 - Tracking the Knee Marker

The knee marker changes in appearance over the course of the video sequence. We will
process the image to enhance the appearance of the marker, and then perform two auto-

tracks to ensure the most accurate results.

Advance the video to frame 40 and click the Add button to create a new feature. Open the
Image Processing control panel and click the Display B&W button. Then, adjust the B&W
Image Settings sliders to enhance the appearance of the knee marker relative to the skin

surrounding it [ Figure 4 ].

Figure 4

Define and set a region around the knee marker [ Figure 5 ]. The size of the region is not as

critical to a successful track as it was for the hip marker.

Figure 5
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Click the % icon to open the Track Settings window and type “Knee” in the Feature Label
text field. Next, check the Enable button in the Feature Rotation frame. Click the Apply

button followed by the Close button to set your changes.

Click the Track Forward button. After ProAnalyst completes the forward track, go back to
frame 40 of the video and click the Track Backward button. When the video moves past

frame 0 and into the negative frames, click Abort Tracking.

To delete these extra points, set the video to frame -1. Right click on the video and select
Feature Tracking = Clear Features & Current Feature, Current Frame Backward from
the pop-up menu [ Figure 6 ].

= EE DEPMEH UG E0 B bR

Feaiure Tracking Mode

_ o || ana
Load Save & Automatic

Features

Add Remewe. Clear

Hip *

[ e ]

=

Play

-
2 1 ENEY
‘ Yiew 2] Rnee ENIRY

video Menus

Graph Menus

M Display Layers
Knee 9
R 3¢ 5 O -

Modify Recorded Parameters

v ol

Show Current Feature
Shaw Calibration

Show Search Reglons Define Region SetRegion
v Show Template Regions
e — Feature Lines Show Pairts

Shaw Lines Conligure Showal =

Trackinn
Al Features, Current Frame
2l Features, Al Frames

ANl Features, Current Frame Forward
All Features, Current Frame Backward
Current Feature, Current Frame
Current Feature, Al Frames
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Figure 6

When the tracking has been completed successfully, click the & icon to lock the feature.

Step 3 — Tracking the Ankle and Foot Markers

The foot and ankle markers present a number of difficulties that make accurate auto-
tracking extremely difficult to achieve. The ankle marker is positioned on a white sock, and
is therefore not visually distinct enough for auto-tracking to pick up. The foot marker, on the
other hand, actually separates from the foot in frames 17 — 19, making any attempt at auto-
tracking a futile endeavor. In these cases, the features of interest will have to be tracked
manually.
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Go to frame 0 of the video and click the Add button to add a new feature. Label this feature
“Ankle”. Set the feature tracking palette to Manual mode.

Left click on the ankle marker to position the reticle on that spot [ Figure 7 ].

Figure 7

Click the Set Point button to set a tracking point. The video will automatically advance to
the next frame. Points can also be set manually by holding down the Ctrl key and right
clicking the mouse. When a large number of points have to be set, this method is more

convenient than repeatedly clicking the Set Point button.

Continue manually setting points until the ankle marker disappears on frame 78 [ Figure 8 1.

Adjust the Image Processing settings as necessary to most easily visualize the marker.
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Figure 8

Add a new feature and repeat the previous steps to manually track the kicker’s foot until it
leaves the video in frame 53 [ Figure 9 ]. An easy way to do this would be to use the foot
marker as a guide until it separates from the foot in frame 18. The marker’s former position
can be easily estimated for frames 19 — 53.

Figure 9
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Step 4 — Creating a Stick Figure

Click the Configure button to open the Line Configuration

window [ Figure 10 ].

First, click the Add Line button to create a new feature line.
Then select Feature 1 in the Possible Points frame, and
click the ® button to move it into the Sequence of Points

in Line frame. Follow this by adding Feature 2 and Feature

3 to the sequence, as well.

Line Configuration 3]
Line Number [1 = AddLine | Remove Line
Line Froperties:
Display Lines | Curent Frame | St [Sold |
1™ Highlight Line in Current Frame Color [ Sizz |2 ~
Define Line Measurements
Possitle Sequence of
e o e ¥ Show Angle Measurements
Fogrel [ Shaw Length Measurements
eeeeee (o8
Feature 3
o c
-
=
Font
1 Famly |l ~
w8 Colr | 52c[16 =]
W Bold [~ halic [ Underine
Figure 10

Check the box labeled Show Angle Measurements. When you click the Apply button, an

angle measurement will be drawn between the kicker’s hip, knee, and ankle.

Repeat the previous steps to add a feature line between the kicker’'s knee, ankle, and toe.

Click the Close button to exit the configuration window.

-—
With the angle lines configured and drawn, click the *#* icon associated with each feature to

hide the tracking points. The lines extending down the kicker’s leg from his hip to his toe will

remain visible [ Figure 11 ].

Figure 6

When the video is played back, you will see an accurate stick-figure representation of the

kicker’s leg overlaid on the original video image. The joint angles (represented by the angle

lines) can be graphed in the same way as any other 2D feature.
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Tutorial 8: Analyzing a Golf Swing

This tutorial demonstrates how multiple analysis modules and tools can be applied to the
same video file. In this example, a close-up shot of a golf swing will be analyzed using both
the 2D Feature Tracking and the 2D Line Tracking toolkits. Each toolkit has its own
purpose and applications, and there may be cases where one toolkit alone does not have
the capabilities to perform a full and accurate analysis of a video. Fortunately, combining
multiple analysis tools on a single video is no more difficult than applying them individually,
as this demonstration will show.

Files Needed for This Tutorial

1. golfswing.avi

Step 1 — Image Calibration

Launch ProAnalyst and create a new project. Add the golfswing.avi video file to the project
and open the Measurement Window.

One goal of this analysis the extraction of the speed of the golf ball after it is struck by the
club. Acquiring an accurate measure of this value will require that the video be calibrated to

real-world units, and that the origin be placed appropriately.

Click the " icon to open the Image Calibration control panel. To establish a pixel
conversion value, we will define two points in the image and define the distance between
them as a real-world value. The golf ball is a perfect calibration object, as its diameter is a

known value, and two points can be easily set on either side of it [ Figure 1 ].

Figure 1
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Click the % icon associated with Calibration 1 to open the

Calib STalE

SetPoint#1 | et Paint #2 |
15

Calibration 1 Settings window. Position the reticle on one

side of the golf ball and press the Set Point #1 button.

Inches - -
Reposition the reticle on the other side of the golf ball and
. ) Apply Scale »» IT pixels £in
press the Set Point #2 button [ Figure 2 ].
Figure 2
After the two points are set, it will be necessary to input a
calibration value for the distance between the points. A Calibrate Scale
regulation golf ball is no less than 1.68 inches (4.27 SetPorti | setPoniz |
. i i i ) . Distance Between Points
centimeters) in diameter. Input this value into the Distance [[68  [inches _v]
Between Points text box, and make sure that “Inches” (or Aoy Scale > || 48 pirels /i
centimeters) is the active scale unit [ Figure 3 ]. Click the
Figure 3

Apply Scale >> button to set the new scale factor.
With the scale calibration established, all that remains is to set a new origin point. As
distance and speed measurements for the golf ball will be calculated relative to this position,

it makes sense to set the origin at the center of the ball.

Click in the center of the golf ball to position the reticle at that

point. Press the Set Origin button to move the axis lines to the Huick Set
new origin. If the axis lines are not aligned correctly (X pointing | @ _
to the right, Y pointing up), click the appropriate box in the |

Quick Set frame to reorient them [ Figure 4 ]. When the origin
has been positioned and oriented correctly [ Figure 5 ], click Figure 4
the Apply Origin and Tilt >> button.

Figure 5
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Step 2 — Tracking the Speed of the Golf Club

As a golf club is an object with no distinct features suitable for template tracking, we will use
the 1D Line Tracking tool to calculate the speed at which the club is swung. Different
positions along the shaft of the golf club will be moving at different relative rates, so a series
of six lines will be used to track the speed of the club along multiple paths.

Begin by clicking the 1D icon to open the Line Tracking

Line Tracking
control panel, and then click the Enable button to activate the Lifie Treskig
Dizable

fptioris

panel. It will not be necessary to calculate a best-fit circle for B i

this analysis, therefore that option can be disabled by un- _toxd | save || | N
checking the Circle Fit box in the Options frame [ Figure 6 ]. Figure 6

When the Line Tracking control panel was enabled, one line
was automatically added to the project. This line must be
repositioned so that it covers the entire range of motion of the
golf club. Click the Modify Line button to activate the line
editing mode. You can change the position and length of your
line by clicking and holding down the mouse over one of the
line end-points, and then dragging that end point to a new
position on the screen [ Figure 7 ]. The Modify Line button can Figure 7
be clicked again to reset the line, allowing you to restart the line

editing process if necessary.

With line editing mode active, click and drag the mouse across the video image from a
starting point near the top-left, to an end point near the top-right of the frame [ Figure 8 ].
When you are satisfied with the positioning of the line, click the Set Line button to apply the

changes.

Figure 8
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To create an accurate picture of the speed of the golf club, multiple tracking lines will be
needed. New lines can be created by clicking the Add button, and modified by clicking the
Modify Line button as described above. Add and position 5 more lines below the existing
tracking line [ Figure 9 ]. For the moment, the lines will remain at their default track settings.

} igur 9

Froperties
With the six lines positioned down the length of the golf club, Add | Remove Clear &1
you can begin the line tracking process by clicking the Track 1 o En
2

Forward button. As the video advances, it will be obvious that 3 9,

. . . 4 oMo &
the default settings for the line tracking are not adequate to 5 omo a
accurately track the motion of the golf club through each 8 oKD 2
frame. Click the % icon associated with Line 1 [ Figure 10]to
open the Line Settings window. Madify Line Set Line |

Figure 10

The Line Settings window [ Figure 11 ] provides access to all
of the parameters involved in line tracking. From the Search Line 1 Settings X

Image Settings

Type dropdown menu, select “Peak Derivative”. This option
Show Settings | Apply Current to Feature|

will return a single point for each frame of video, representing

¥ Useimage processing filkers

the point of highest derivative along the line. Search Parameters
v Active

Search Type
Each line in the project has its own associated Line Settings,

Transhior TOEE

Threshald

Max. Targets

the parameters of which can be modified individually. It the

search parameters are identical for every line in a project, it is Thickness 3 ]
possible to apply any changes you make to every line Fiter Cosficient 1.0
simultaneously. To do this, check the “Apply Settings to All oo | Detan | [ ciose |

Lines” box in the Line Settings window. Figure 11



132 ProAnalyst Tutorial Guide

Click the Apply button, followed by the Close button to apply the new search type to the
line. If the Close button is pressed without the Apply button having been clicked, the
window will close but the changed settings will not take effect.

With the new search parameters applied to the lines, press the I"_‘ button to go to frame 0 of
the video. Click the Track Forward button to restart the tracking. As the video advances this
time, you should see the tracking points on each line accurately follow the motion of the golf
club through the frame [ Figure 12 1].

'- F|gur1
Step 3 — Tracking the Motion of the Golf Ball

Unlike the featureless nature of the golf club, the golf ball is an ideal object for ProAnalyst’s
2D Feature Tracking capabilities. Open the Feature Tracking control panel by clicking the
20D icon on the right side of the Measurement Window, and then click the Enable button to

activate the control panel. Make sure the video is currently on frame 0.

When the Feature Tracking control panel was activated, one Features

Add Remove Clear
feature was automatically added to the Features box [ Figure 13 | | |

]. Press the Define Region button, and then in the video frame
click and drag a box around the golf ball. The size and position of
the box will impact the accuracy of the automatic tracking

algorithm, so it is recommended that you keep the box as close

as possible to the size of the golf ball. If necessary, you may

Define Region Set Region

click the Define Region button again to reset the region and
redraw the box. When you are satisfied with the size and Figure 13
placement of the box, click the Set Region button to highlight the

golf ball [ Figure 14 ].
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igur 14
As with the 1D Line Tracking, each feature you track has its own
set of customizable parameters. Click the % icon to open the

Feature 1 Track Settings window [ Figure 15]. You may type a
label for the golf ball in the Feature Label text field.

Check the boxes marked “Enable X” and “Enable Y” in the
Trajectory Prediction frame. These options have been selected to
counteract the changing lighting conditions on the golf ball, and
any potential impact that may have on the automatic tracking
functions. With these options enabled, ProAnalyst will predict
where the most likely position of the golf ball is with respect to its
motion in previous frames of the video. It will then begin its

search for an object match in that area.

Click the Apply button, followed by the Close button to confirm the

new tracking parameters.

3

Feature 1 Track Settings
Feature Label
|Golf Ball

Image Settings

Show Settings | Apply Current to Feature |

[V Use image processing filters

Search Parameters

Search Region Mulliphier [>100%] 160

Threshald Tolerance [0.0-1.001 075
Limit on Distance From Last [%] 160
Frames to Search After Loss 0

¥ Sub-pixel accuracy | Enhanced match

Feature Rotation

I Eretle ALngular Range [deg) 10
Step Size [deq)

-

Trajectary Prediction
[v Enable® I Enable/ I EnableR

Default | Clase

Figure 15

With the search parameters in place, click the Track Forward button to begin auto-tracking

the golf ball. ProAnalyst will track the ball until it leaves the video in frame 63 [ Figure 16 ].

F gure16 '
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Step 4 — Graphing and Filtering the Tracking Results
Now that the golf club and golf ball have been successfully tracked, the results of the tracks
can be graphed and analyzed. Open the Graph Configuration control panel by clicking the

m icon, located at the bottom of the right-side Measurement Window toolbar.

Select Items to Add to Graph

Click the Add button to open the Select ltems to Add to Graph

window. You will see two items in the window, labeled 1D and

=10 ~

[Cline - Target 1-X

Cltine - Target1-v

[OLline1- Target 1 - Dist

Line 1 - Target 1 - Speed

DlLine2 - Target1-%

Oline2- Target 1-¥

CJLine2 - Target 1 - Dist

Line 2 - Target 1 - Speed

2D. Click the + sign next to the 1D item to expand the list of items

that can be graphed. From this list, check the boxes labeled

” o«

“Line 1 — Target — Speed”, “Line 2 — Target — Speed”, etc., until

[line - Taget 1-X

CLine3-Tagst1-¥

you have selected the speed value associated with each of the e g
six 1D tracking lines [ Figure 17 1. Click the OK button. [e= |
Figure 17

Note that the Y-axis values are currently being displayed in pixel values [ Figure 18 ], not

the real-world units that were specified earlier.

I
0.05
Time [seconds]

Figure 18

To change the calibration of the Y-axis, you must first reopen
Units & Export
Feet - | | Test - Export

the Line Tracking control panel. At the bottom of the panel is a

frame labeled Units & Export. Select “Feet” (or “Meters”) from
the dropdown menu [ Figure 19 ], and you will see the graph
automatically adjust to display your results in calibrated units.

Figure 19

Femave

To arrive at a clearer overall picture of the speed of the golf

club, a series of noise reduction filters can be applied to the

graph lines. To apply a data filter to a graph channel, click the 1|10 -Line 1- Target.. | @ @
2 110 - Line 2 - Target... [

Filter Settings icon [ Figure 20 ] to open the Filtering window 3|10 -Line3-Tawet. |@ |45 B1

associated with a particular graph line [ Figure 21 1. Figure 20
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Begin by checking the Enable Filtering box to activate the Filter List
panel. Click the Add button to create a new filter in the list. Clickingon | o

Data Sample Rate:

¥ Enable Filtering 1000 He

the newly added filter will select it, as well as activate the Type menu

Filter List

in the Properties frame. i |peoe| _oee

From the Type menu, select “Low Pass”. This will activate the next

menu, Style. From the Style menu, select “Butterworth”. The Order Pmd | sere | b | pon |
i i i [CowPose =]
and Cutoff Freq. text boxes will now become active, though the o o
default values will be sufficient for this example. Oidkr o
Cutoff Freq. 100 B
Low Culoft Frequency | :Z
Click the Apply button, followed by the OK button to apply the new High CutotFrequency He
" . . . . . pdate Properties in List
filter to the graph line. Clicking the Cancel button will close the Line e ;
Filtering window without applying any changes. x| o | e
Figure 21

Repeat the preceding steps to apply identical filter settings to the other five graph lines. The

graph window will automatically update as each filter is applied [ Figure 22 ].

I
0.05
Time [seconds]

Figure 22

The steps required to plot the speed of the golf ball are virtually

ok
identical to those of plotting the speed of the golf club. Begin by @ Ten x| _Eon |
reopening the Feature Tracking control panel and selecting

Figure 23
“Feet” (or “Meters”) from the Units menu [ Figure 23 ]. .
Select [kems to Add to Graph
+-1D
Click the Add button, located in the Graph Lines frame, to S

[ Feature 1 [Golf Ball) - %

[ Feature 1 (Golf Ball) - Dist

Festurs 1 (o

open the Select Items to Add to Graph window. Expand the 2D ¢:
item list by clicking on the + sign. Check the “Feature 1 (Golf
Ball) — Speed” box [ Figure 24 ] in the expanded item list. Click
the OK button to add the new line to the plot.

Cancel
Figure 24
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The graph will automatically update to reflect the addition of the ball speed line [ Figure 25 ].

It is not necessary to apply any data filters to the golf ball speed line.

[}
005
Time [seconds]

Figure 25

Graphed data can be exported in plain text format, or directly into a blank Excel
spreadsheet. Both options can be accessed from a pop-up menu that is opened by right-
clicking on the graph window. From the menu, select Graph Menus = Export Displayed
Data > <format> [ Figure 26 ].

Play
View

Video Menus
Graph Menus Refresh Graph
Ex

Display Layers e

Annatations
Line Tracking
Feature Tracking

Modify Recorded Parameters

1
0.05
Time [seconds)

Figure 26




Analyzing Motion in Three
Dimensions

This tutorial will provide users with a step by step guide to performing an analysis with
ProAnalyst 3-D. This lesson will cover the ProAnalyst 3-D Manager, calibration,
measurement, and graphing. Prior ProAnalyst experience is assumed, but not required.
Where necessary other tutorials have been referenced that explain concepts not covered by

this document.

Files Needed for This Tutorial

Robot1.avi
Robot2.avi
Cal1_0.bmp
Cal2_0.bmp
TutorialFixture.fixt

o a0k w Db

Step 1 — Setting Up a Project for 3-D

Copy the TutorialFixture.fixt file into your Program Files\Xcitex\ProAnalyst\Fixtures

directory.

Launch ProAnalyst and create a new Project by selecting File > New Project. Add the
Cal1_0.bmp, Cal2_0.bmp, Robot1.avi, and Robot2.avi files to the Project. For more
information on working with projects, please refer to ProAnalyst Tutorial #1: Learning to Use
ProAnalyst.

The ProAnalyst 3-D Manager
Create a new 3-D Manager by selecting Tools > New 3-D Manager.
Drag the Cal1_0.bmp file into the Calibration 1 frame on the 3-D Manager. Repeat this

process to drag Cal2_0.bmp onto the Calibration 2 panel, Robot1.avi onto the

Measurement 1 panel, and Robot2.avi onto the Measurement 2 panel.
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Untitled 3-D Manager |Z||E|E|
= @+ 5 11E 4 8

3D Manager
B

Import and Export Setup
Calbration ONLY

Import Callbration
Export Calibration

World Reference ONLY

Import Wold Fleference
[B:\Froénalyst\FioboS apien Dan [B-+Proénalyst\RoboS apien Dan Export Wold Reference

3 A

| Btended | Measurement | Calbration | Manager

Units & Evport Riesults

<calbral | [Tet | Ewpont

[D:\PradnalystiboS apien Dan [D:iPrednalystiRiboS apien Dan

[ wl— Ell M
A WAl T S Tk T:[G000000 e

Each time you drop an image or video onto the appropriate panel, the video will open in a
new Measurement Window, and immediately minimize to a position on the bottom of the
screen. Double-clicking on one of the panels will cause the minimized video to expand to full

size for processing or analysis.

After adding the calibration and measurement videos to the 3-D Manager, click the Save
button. The 3-D Manager can now be added to your project file in the same way as a

video source.

Step 2 - 3-D Calibration

Click the Calibration tab on the left side of the 3-D Manager window.
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Untitled 3-D Manager
B-O* % unE + &

3-D Calibration

Fixture

Standard Fisture |- Load From File - =
Load Fisture from File

Paints
" Manual & Automatic

Defins Fist Region
Define Second Fiegion
Locate Align

Display and Eit Points
Import Faint Coordinates
Graph Paints

Calibrate:

Calibrate Wiew

y e B

| Blended | Measurement [ Calibration | manager

FIT T BRI o -
AP A "4 ' uer | 'obo To[0000000 @

|
| !
oon 027 032

3-D Calibration

From the Standard Fixture dropdown menu select the Fig
I=ILre
Model XR3: #300x fixture file. Standard Fixture |- Load From File - +

Click the Define First Region button. Click six points
around the perimeter of the top calibration fixture image.
Make sure that the region encompasses all of the points on
the fixture, and that the points are clicked in the order shown

here.

Click the Define Second Region button, and repeat the

process for the bottom fixture image.

Right-click on the upper calibration image, and select

Locate Point Settings (TOP) from the pop-up menu. Set
the Maximum Pixel Count value to 2000. The other

settings may remain at their default values.

Repeat the process for the lower calibration image by right-clicking on the image and
selecting Locate Point Settings (Bottom) from the pop-up menu.



140

ProAnalyst Tutorial Guide

Click the Locate button. After processing the defined regions, you should see the following

dialog box appear:

ProAnalyst

? : .
\_?l Operation completed. Keep these poinks?

Yes Mo Caneel ‘

Click the Yes button to continue.

Instead of the Operation completed dialog box, you may see the following dialog:

ProAnalyst

& Error locating fixture points,
‘Ef) Unequal number of points located for each image.

Returning unsottedjunaligned point coordinates,
Do nat use these For calibration.

If this is the case, then you may need to redefine the search regions on the calibration

images and/or modify the values in the Locate Point Settings window.

Once the fixture points have been located successfully, click the Align button to straiten out
any misalignments that may have resulted from the automatic detection process. After the
points have been aligned, click the Calibrate button. ProAnalyst will now determine the

positions of the two cameras, and create the 3-D world space for the analysis.

After you calibrate, a Calibration Completed dialog box

. . . . . ProAnalyst
will be displayed. This dialog will show the Mean Error, >
Lo ) . . i Calibration Campleted:
Std Deviation, Min Error, and Max Error inherent in \\,) )
Mean Errar = 0.0200 inches
. . . Skd, Deviati = 0.0116 inch
your calibration. If you would like to try to reduce any san ene
Iin Errar = 0.0025 !nches
calibration error, you may repeat any or all of the Max Error = BB e

previous steps and click the Calibrate button to see the

new calibration settings.

After you are satisfied with your calibration accuracy, you may click the Graph Points
button to see a 3-Axis plot of the fixture. The blue spheres displayed on the plot represent

the positions of your cameras relative to the fixture.
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& Untitled 3-Axis Graph,

3-Axis Graph Lines B
e

byis Graph Lines.

Load | Save ErailE

Guaph liems

Add | Remove. Copy

# Source Yideo

dance.m3d Select
 Source Item
30 - Calib. Firture - Select

*r Source Yideo

dance.m3d Select
¥ Source Item

30 - Calib. Fisture - Select
Z Source Yideo

dance.m3d Select
Z Source ltem

30 - Calb. Firture -2 Select

Update Line Refrech Dala

TR
e e G 4| ShowPoints Slow
b1 IS B S Ry = Zeo | g8 [Showal <] PeyRai 11 s

Step 3 - 3-D Measurement

After calibrating the analysis successfully, the next step is tracking the features you wish to
analyze. The standard 2-D tracking tools are used on both videos of the event, the results of

which are then transformed into 3-D space by ProAnalyst.

When the Robot1.avi and Robot2.avi videos were added to the 3-D Manager, the videos
automatically opened in their own Measurement Windows which then minimized. Restore

the Robot1.avi Measurement Window, and open the Feature Tracking panel.

Enable the panel, and then add four features to the list. Define, Set, and Track four
features on the robot’s body. After the features have been tracked, save the tracking file and

minimize the Robot1.avi window.
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= rabott.avi EEX
AL ENEEEE

Feature Tracking =

Fealure Tracking Mode, -

Disable C Mol | U

Load | Save @ Automatic | B

=]

Features -
Add Remove: Clear

T[wotmes | + [ 8 % | 2

2| <molabe | % |%5 & @ | (2D

R N EE I Y

4| <o labeb > &% | g

£

m

Define Fegion Set Region [~ |

Feature Lines Show Faints
Configure Shaw Curen v
Tracking
Track Backward || Track Fomard

Units & Export

Pl v|[Ten x| Expot
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| m[a|im]pri] ra|gs| S

—
0w 0% 0@ oo emkRaR 1 it
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Restore the Robot2.avi Measurement Window and repeat the previous steps to track and
save the same four features on the robot. When defining features in Robot2.avi, be certain
that the features correspond to the same features in Robot1.avi (i.e. Feature 1 is the belt
buckle in both videos).

After the identical features have been tracked on both videos, click the Measurement tab on

the left side of the 3-D Manager window.

Click the Add Matching button to populate the 2-D Data Sources list with the tracked

features from Robot1.avi and Robot2.avi.
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testing.m3d
EH oo @+ 511 E| $ 2

®
2D Data Sources b
1|20 -Feature1(): 2D -F... 3\12* L
2 |20 -Feature 2(): 2D - F... [ 9% J..
3 |20 -Featwe 3(1: 20 -F... [ 9%
47|20 - Feature 4 ): 20 - F... 5 9%

Add 2dd Matching Remave

[B\ended[ Measuremert  Calibration [Manager

Ok 3
Update Upper Point |
[et-
- Update Lower Paint |
XYZ = [-2.253, -5.471, 6.6587] +1.9814in 2 R
3D Data Points
Display Points |
Graph Points |

\E5 of

(x2
[ -

4¢1, -6.657] =1.9814in

11 1 1| F ’D— [
[ | » [m|«ifim]on ?DU‘ "thar ' deoo ! lagoo To[000D000 ge

Note: Add Matching will pair up tracked features based on the feature number in the
Measurement Window Feature Tracking list; hence the instruction to match up the
features tracked in Robot1.avi and Robot2.avi matched one another. If the feature numbers
in a pair of videos do not match, feature pairs can be manually added by clicking the Add

button and selecting each feature pair manually.

Regardless of how the feature pairs are added to the 3-D Measurement panel, the two
video panels will automatically update to display the tracked points. At this point the
matched features can be plotted in a new 3-Axis Graph, but to insure proper orientation of

the plot, the World Reference Frame must be modified.

Click the Blended tab on the left side of the 3-D Manager window. By default this panel will
display the robot video images overlaid on the calibration fixture images. Drag the Blending
slider, located in the top left corner of the panel, to the extreme right so that only the robot

videos are visible.
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tutorial3D.m3d
H = O+ % 19| 4 &

[B\SHGEU Measurement [Calibration [Manager

3-D World Reference

Reference Frame Blending
[~ UseWorld Reference —J

Define Transfomation

Click the Use World Reference checkbox to activate the
Define Transformation panel. Click the Two Points on

Z-Axis radio button to enable that control set.

Click on the Feature 1 in both video panels to position the
cursors. Click the Get Current button located to the right
of the First Point label to set the First Point text fields.

Repeat the previous step to position the cursors and set
the Second Point coordinates using Feature 3 as a

reference point.

Click the Apply button.

Define Transtormation
™ Ratation and Translation

| |
[inches ™ <]

(* Twao Points on Z-twis

First Paint Get Current

|-3.35044  |0.303243 |-4E5425

Second Paint Get Eunent|
|-367113 [1.02926 |-656349

Z Coordinate of First Point Units:

| 0 | Inches ﬂ

Base Angle [degrees, T4 positive]
0

| Apply 1

L
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Step 4 - 3-D Graphing

After adding the tracked feature pairs to the 3-D Measurement panel, click the Graph

Points button. A new 3-Axis Graph will be created with the tracked features automatically

added and displayed.

3-Axis Graph Lines by
F-Axis Graph Lines e
Load Save ‘ Configure ‘
Graph Items
Add | Hemove| Copy |
1% = tutorials... | |5 B B B
2 |¥ = tutonial3.. et o bl
3 [% = toriald.. |4 |4 B EWED
4 [ = witorisl3.. = bl
7 Source Yideo
Select
7 Source |tem
Select
' Source Yideo
Select
r* Source |tem
Select
Z Source Yideo
Select
Z Source |tem
Select
Update Line | Refresh Data |
L .
r_lh I:|0 4 | Show Points Slow — Fast
ML IR ot Zeo | @8 | [Shonal =] PyRaio 11 i

Click the Configure button located in the top-left corner of the graph window to open the

Line Configuration E

Line Configuration window.

Click the Add Line button.

Select Item 1 and click the right arrow to move it into the
Sequence of Points in Line panel. Repeat this step to move
Item 2, Item 3, and Item 4 into the same panel. Finally, add

Item 2 to the list a second time.

Click the Apply button, followed by the Close button. The

displayed points will now be connected by a closed stick-figure.

Line Number |1 -

W Show Line

Line Praperties
Stle | Solid

Defing Line

It
Item 4

Apply |

Remaove Line

Color [ | Size m

Add Line

-

Cloze
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The 3-Axis Graph view can be rotated by clicking and dragging
the mouse on top of the graph panel. The view can be zoomed
in and out using the mouse wheel.To make the plot easier to
see, a number of options can be enabled within the graph
window. Click the “# icon to open the 3-Axis Graph

Sources/Options tool palette.

Click the Fixed Bounds check box to open the Additional
Graph Options window.

Click each Fixed #-Axis Bounds checkbox, as well the Get
Current button associated with each axis. The values in the
Minimum and Maximum value text boxes will update to reflect
the bounding area of the plot. Click the OK button to close the

window.

3-Axis Graph Sources/Options

Sources

* tutorial30.m3d : 30 - Data A~
: tutonial30.ma3d : 30 - Data
: tutonial30.ma3d : 30 - Data
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: tutonial30.ma3d : 30 - Data
: tutonial30.ma3d : 30 - Data
: tutonial30.ma3d : 30 - Data
: tutonial30.ma3d : 30 - Data
: tutorial3D.m3d 0 30 - Data o
£ >

DI KK N RN <X

R N N

Open Yideo Load Default Source |

Open and Load All Default Sources |

Options

[~ Display legend [two styles]

™ Fast draw when dragging

v Major grid lines W Minar grid lines
Iv Black background

¥ Fized bounds
Shaw W =y [ 2 [ %Z plane
Logatithmic [ % [ % | Z axis

[~ Show cursors

Refresh Data |

Finally, select Show Current from the Show Points dropdown list and press the ™ | button

at the bottom of the graph window to view the tracked event in thre

e dimensions.
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